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Configuration
Introduction

The OkiLAN Internal Print Server is a fast 100BASE-TX/10BASE-T 
network interface.

This network print server supports IEEE802.2, IEEE802.3, 
Ethernet-II and SNAP and can detect those frame types 
automatically.

Also, it supports major protocols such as TCP/IP, EtherTalk, 
NetBEUI, Netware, Appletalk, and Rendezvous/Bonjour.

This section details the specification and several software utilities.

For multiple emulation printers, change the emulation in the 
Printer Menu settings to Auto or PS before printing the 
self-diagnostic test and settings.
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Specifications

    
CPU Falcon
Frame types IEEE 802.2

IEEE 802.3

Ethernet-II, SNAP, AUTO
Network interface 100BASE-TX

10BASE-T
Network protocols TCP/IP

Network layer  ARP, RARP, IP, ICMP, IPV6, UPnP, 
AutoIP

Session layer  TCP, UDP

Application layer  LPR, FTP, TELNET, HTTP, IPP, BOOTP, 
DHCP, SNMP, SMTP, NCP, SAP, NLSP, RIP, NDS, NDPS, 
SPXII, Pure IP, SMP on TCP/IP, SMB on NetBEUI 

IPX/SPX (NetWare)

Remote printer mode (up to eight file servers and 32 
queues)

Print server mode (up to eight print servers)

Encrypted password supported in print server mode

SNMP

EtherTalk

ELAP, AARP, DDP, AEP, NBP, ZIP, RTMP, ATP

NetBEUI

SMB, NetBIOS

DDNS, WINS, Rendezvous/Bonjour
Functions Self-diagnostic test printing

Banner supported

Monitoring/configure by Web browser

Printer status notification by E-Mail
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Self-diagnostic test

With the printer power switched on, press the print server test 
button for more than three seconds and release. The 
self-diagnostic test results and configuration settings are printed.

Printed self-diagnostic test sample

If “NG” is displayed instead of “OK” see the “Troubleshooting” 
chapter.
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Printed configuration settings sample

    networkinfo_pg1.jpg  
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  networkinfo_pg2.jpg 
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Configuration Utility

Available utilities

You can configure the print server by using one of the following 
methods:

     

Utility Features System requirements

Quick Setup Configure the print server 
easily and simply without 
installing any software 
packages into your system. 
You can set the following:

Enable/disable TCP/IP, 
NetWare, EtherTalk, NetBEUI 
protocols.

> Set IP address, Subnet Mask 
and Gateway for TCP/IP 
manually or by using DHCP.

> Set NetWare Mode and create 
Queue/Print Server/Printer 
objects.

> Zone name and Port name for 
EtherTalk.

Windows95/98/Me/NT4.0/
2000/XP (TCP/IP protocol or 
IPX/SPX protocol should be 
installed).

To create a NetWare queue, 
NetWare Client 32 or 
IntranetWare Client should 
be installed in your system.

Web browser Configure the print server and 
printer by using a Web 
browser such as Microsoft 
Internet browser or Netscape 
Navigator.

Microsoft Internet Explorer 
Version 3.0 and higher or 
Netscape Navigator Version 
3.0 and higher. Operating 
system that supports Web 
browser.

AdminManager Configure the print server in 
detail.

Windows95/98/Me/NT4.0/
2000/XP (TCP/IP protocol or 
IPX/SPX protocol should be 
installed). to create a 
NetWare queue, NetWare 
Client 32 or IntranetWare 
Client should be installed in 
your system.

TELNET Configure the print server 
using TELNET.

Third-party vendor developed 
TELNET client package. 

A TELNET Application is 
standard in Windows/UNIX/
Linux.
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SNMP The printer and print server 
can be controlled using 
third-party vendor developed 
SNMP application.

Third-party vendor developed 
SNMP application.

Utility Features System requirements
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Using Quick Setup

Quick Setup utility allows you to configure the print server easily 
and simply without installing any software packages.

You can configure the following:

> Enable/disable TCP/IP, NetWare, EtherTalk, NetBEUI 
protocols.

> Set IP address, Subnet Mask and Gateway for TCP/IP 
manually or by using DHCP.

> Set NetWare mode and create Queue/Print Server/Printer 
objects.

> Zone name and Port name for EtherTalk.

Configuration requires a PC with Windows 95/98/Me, Windows 
2000 Advanced Server/Professional or Windows NT Server 4.0/
Work-station 4.0, Windows XP running TCP/IP or IPX/SPX 
(NetWare).

This utility can only be used on a PC that can be connected to the 
network with TCP/IP or IPX/ SPX.

This utility must be used on a PC that is located in the same 
segment as the printer. To create a NetWare queue, NetWare 
Client 32 or IntranetWare Client should be installed in your system.

The following explanation uses Windows 98 as an example. 

1. Insert the CD-ROM provided with your printer into the 
CD-ROM drive. 

If the Menu Installer does not start automatically, click 
Start→Run→Browse. Browse to your CD-ROM and click 
Setup→Οpen→OK.
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2. Select [Optional Utilities] 

     netsofbutton.gif   

3. Select [Install Quick Setup Utility].

      install_configbut.gif    

4. Select the language.    admgr_qsetbut.gif  

        sel_lang.gif  

5. Select OKI Device Quick Setup.

    sel_quicksetup.gif  

6. Follow the on-screen instructions.

  quicksetup.gif   
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> The NetWare Client 32 or IntranetWare Client should be 
installed on the PC used for the creation of network queues. 
Installation enables the user to create network queues and 
perform other functions.

7. If the settings are correct, click [Execute]. The new settings 
are transmitted to the network card but the network card is 
still operating with pre-transmission settings.

8. Click [Finish] to validate the new settings. Depending on the 
model, the printer may have to be switched off and on 
again.
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Configuration - 15



Using a Web browser

If the print server is connected to the network using TCP/IP, its 
settings and the printer menu settings can be configured using a 
Web browser, such as Microsoft Internet Explorer Version 4.0 and 
higher, or Netscape Navigator version 4.0 and higher. No 
guarantees are offered for other browsers. Refer to the relevant 
manuals for details of how to launch and use the browser.

The network addresses used in this manual are shown as examples 
only. Network addresses used in your installation must be 
generated from your own network. To apply configuration changes 
using a Web browser, you will be prompted for a username and 
password.The username is [root] and the default password is the 
last six digits of the Ethernet address.

The following explanation uses Windows 95 and Microsoft Internet 
Explorer version 4.0 as an example.

1. Configure the IP Address, Subnet Mask and Gateway for the 
network card. Launch the Web browser, enter the IP Address 
of the network interface card in [Address (Location/
Position)] and press the [Enter] key. The Printer Status 
screen is displayed.

   status.jpg  

2. Click on a tab to see a particular Category, then click the 
items you want to change in the left column. For more 
details of corresponding items in WEB and TELNET 
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equivalents, see the description in the Configurable Items 
and Default Values table starting on page 51.

3. To ensure correct operation, follow the procedure below for 
the appropriate network browser.

Microsoft Internet Explorer

a. Select [Internet Options] in the [Tools] menu.

b. Click on the [General] tab and click [Settings] in 
[Temporary Internet files].

c. Select [Every visit to the page] in [Check for newer 
versions of stored programs]. 

Netscape Navigator

a. Select [Settings] in the [Edit] menu

b. Click [Cache] in [Details].

c. Select [Once per session] in [Document in cache is 
compared to document on network].

If you change the window size of the browser immediate-
ly after changing the configuration, [Security informa-
tion] may be displayed. Uncheck [Display this message 
next time] in the dialogue.

4. After making changes, click [Submit]. 

5. Enter [root] in User name and your password (default is the 
last six digits of the Ethernet address) in Password and click 
[OK]. 
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6. After the new values are transmitted to the network card, 
the following screen is displayed. If a different message is 
displayed, check the settings.

     ENTERPASSWORD.jpg    

For example: For Ethernet address 00:80:92:01:00:D2, a default 
password is [0100D2]. The Ethernet address (MAC address) is 
displayed during the self-diagnostic test.

The root password can be changed to allow you to configure the 
print server and printer by using a Web browser. The default 
password is the last six digits of the MAC address. 

To change the root password for configuration via a Web browser, 
access [http://OKILAN IP address or hostname>/
system_password.htm]. After inputting the current root password, 
this screen is displayed:

     bmp21.jpg  

Input a new root password in [New Admin Password] and [Confirm 
New Admin Password] then select [Submit] button. 
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The root password for configuration via Web browser is different for 
AdminManager/TELNET/FTP. These passwords can be set in 
AdminManager or TELNET. 
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Standard Setup Using AdminManager

AdminManager is a powerful Microsoft Windows-based utility to 
configure all print server functions by using a graphical user 
interface. 

Configuration requires a PC with Windows 95/98/Me, Windows 
2000 Advanced Server/Professional or Windows NT Server 4.0/
Work-station 4.0, Windows XP running TCP/IP or IPX/SPX 
(NetWare).

This utility can only be used on a PC that can be connected to the 
network with TCP/IP or IPX/ SPX and must be used on a PC that is 
located in the same segment as the printer.

To create a NetWare queue, NetWare Client 32 or IntranetWare 
Client should be installed on to your system.

The following explanation uses Windows 98 as an example.
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Installation

The following explanation uses Windows 98 as an example. 

1. Insert the CD-ROM provided with your printer into the 
CD-ROM drive. 

If the Menu Installer does not start automatically, click 
Start→Run→Browse. Browse to your CD-ROM and click 
Setup→Οpen→OK.

2. Select [Optional Utilities] 

     netsofbutton.gif   

3. Select [Install Quick Setup Utility].

      install_configbut.gif    

4. Select the language.

       sel_lang.gif    
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5. Select OKI Device Standard Setup.

    sel_quicksetup.gif     

6. Follow the on-screen instructions. If you want to install 
AdminManager on your local drive, select [Install and 
Execute]. Otherwise, select [Execute from CD-ROM].

      adminmgr_execute.jpg 
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Interface

Select [Start]→[Programs]→[OKI Setup Utility]→[Admin Manager].

File menu

In the [File] menu, the following item can be selected:

   

Item Function

Search Search printers in your network and list all printers 
that have the OkiLAN installed.
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Status Menu

In the [Status] menu, the following items can be selected:

Item Function

Printer Status Current printer status is displayed:

      bmp10.jpg  

System Status Displays current OkiLAN configuration. 
Configuration data can be saved as log file.

     bmp11.jpg    

List of Configuration 
Items

Displays current  configuration. Configuration data 
can be saved as log file.

  bmp13.jpg  
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Setup Menu

In this menu, the following items can be selected:

 

Item Function

Oki Device Setup Configure the OkiLAN.
Setup by HTTP Launch the default browser in your environment to 

access the selected printer’s web page.
Setup by TELNET Launch TELNET application in your environment to 

access the selected printer’s TELNET port. 

Note: The TELNET application is not included as part of 
the OkiLAN package. Install the TELNET package on to 
your system. For further information, see your 
Windows manual.

Create Netware 
Queue

Create a NetWare queue.

Delete NetWare 
Object

Delete NetWare object.

Reset Reset the selected network interface card. 
Test Print Print self-diagnostic test pages.
IP Address Setup Set static IP address of network interface card 

manually. 
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Oki Device Setup

In this section you can configure the print server. It contains 
details for the following selectable tabs:

> General

> TCP/IP 

> Netware

> EtherTalk

> NetBEUI

> SNMP

> E-Mail (Send)

> SMTP

> Maintenance

The following section explains each tab’s functionality.
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General Tab

This allows you to set or change the root password used for Admin 
Manager, TELNET and FTP.
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TCP/IP Tab

This allows you to configure TCP/IP related items.   

       bmp22.jpg  
   

Location Comments

Change root 
password

You can set/change the root password for 
AdminManager, TELNET and FTP.

   bmp21.jpg      

Location Comments

Use TCP/IP 
Protocol

Set TCP/IP protocol as enabled/disabled. 

Use DHCP/BOOTP Check this item if IP address, subnet mask, default 
gateway and IP addresses for DNS primary server and 
secondary servers are retrieved from the DHCP or 
BOOTP server. Otherwise, clear. 

IP Address Set the IP address of the selected network interface 
card.

Subnet Mask Set the subnet mask of the selected network interface 
card. 

Default Gateway Set the default gateway of the selected network 
interface card. 
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To find corresponding items in WEB and TELNET, see the 
equivalent in the Configurable Items and Default Values table that 
starts on page 51.

DNS Server . . . Set IP addresses for DNS primary and secondary 
servers, and allows you to use DDNS.

    bmp23.jpg  

Auto Discovery Use Network PnP, use Bonjour, set Device Name.
WINS Server Set Primary Server, Secondary Server, Scope ID.

Location Comments
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Netware Tab

This is where you can configure NetWare related items.

  bmp24.jpg  

         

Location Comments

Use NetWare Protocol Set NetWare protocol as enabled/disabled. 
Print Server Name Set Print Server name. 
Frame Type Set primary NetWare frame type. 
Operation Mode Set NetWare mode. 
Check box besides 
Bindery Setup

Check if you want to use the Bindery mode and 
Bindery Setup button becomes available. If it is 
unchecked, the button is greyed out. 
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Bindery Setup Configure items related to Bindery mode.

  bmp25.jpg  

In this dialogue box, the following items can be 
configured. 
Available File Server 
and Selected File 
Server.

Select file servers to 
connect. Up to eight file 
servers can be 
selected. Select a 
server from Available 
file server list and click 
>>. The server is 
copied to Selected file 
server box. 

Password. Set password for Print 
Server.

Job Polling Time. Set print job polling 
interval in seconds.

NDS Setup Set NDS tree and context where Print Server was 
created.

   bmp26.jpg  

Location Comments
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RPRINTER Setup Available if you select RPRINTER mode in 
Operation Mode.

   mp27.jpg  

By selecting the [RPRINTER] button, this is 
displayed:

   bmp28.jpg  

NDS or Bindery Show the Available 
print server tree in NDS 
mode or Bindery mode.

Available print server 
and Selected print 
server

Select file servers to 
connect. Up to eight file 
servers can be 
selected. Select a 
server from Available 
file server list and click 
>>. The server is 
copied to Selected file 
server box. 

Time Out Set duration from the 
last data’s arrival to 
freeing of the port in 
seconds. 

Printer Name Set the NetWare printer object name.

Location Comments
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EtherTalk Tab

This allows you to configure EtherTalk related items.

       bmp29_a.jpg  

       

NetBEUI Tab

This allows you to configure NetBEUI related items.

     bmp30.jpg 
        

Location Comments

Use EtherTalk 
Protocol

Set EtherTalk protocol to enabled/disabled.

Printer Name Set EtherTalk Printer object name.
Zone Name Set the zone name to which the OkiLAN belongs. 

Location Comments

Use NetBEUI 
Protocol

Set NetBEUI protocol to enabled/disabled.

Short Printer Name Set a computer name for the OkiLAN. 
Workgroup Set a work group name to which the OkiLAN  belongs.
Comment Set the comments for the OkiLAN.
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SNMP Tab

This allows you to configure SNMP related items.

  bmp31.jpg 
        

Location Comments

SNMPv1 
Settings

Community names: SNMP Write Community, SNMP Read 
Community. 

SysContact Set SysContact (printer manager) name.
SysName Set SysName (printer model name). 

SysLocation Set SysLocation (the location where the printer is 
installed).
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Printer Trap 
Setup . . .

By selecting the button, the following dialogue box is 
displayed:

            bmp32.jpg     

In the dialogue box, the following items can be 
configured:

Printer Trap 
Community Name

This community name is assigned to 
outgoing printer status traps such as 
off-line, paper out, etc. 

TCP#1—5 Set the IP address to which a Trap 
packet will be sent. You can set up to 
five IP addresses. 

Detail . . . By selecting the Detail button, the 
following items can be configured:
Trap Enable Set sending a Trap 

packet, enabled or 
disabled, for each 
destination.

Printer Reboot Set sending a Trap, 
enabled or 
disabled, when the 
printer restarts.

Receive Illegal Set sending a Trap, 
enabled or 
disabled, when 
illegal data is 
received.

On-Line Set sending a Trap, 
enabled or 
disabled, when the 
printer turns to 
On-Line. 

Off-Line Set sending a Trap, 
enabled or 
disabled, when the 
printer turns to 
Off-Line. 

Paper Out Set sending a Trap, 
enabled or 
disabled, when 
paper is out.

Location Comments
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Printer Trap 
Setup . . .

Detail . . . Cover Open Set sending a Trap, 
enabled or 
disabled, when the 
printer cover 
opens. 

Printer Error Set sending a Trap, 
enabled or 
disabled, when any 
errors occur.

IPX Set node address and network address 
to which a Trap packet will be sent.

Detail . . . By selecting the Detail button, the 
following items can be configured:
Trap Enable Set sending a Trap 

packet, enabled or 
disabled, for each 
destination. 

Printer Reboot Set sending a Trap, 
enabled or 
disabled, when the 
printer restarts.

Receive Illegal Set sending a Trap, 
enabled or 
disabled, when 
illegal data is 
received.

On-line Set sending a Trap, 
enabled or 
disabled, when the 
printer turns to 
On-Line. 

Off-line Set sending a Trap, 
enabled or 
disabled, when the 
printer turns to 
Off-Line.

Paper Out Set sending a Trap, 
enabled or 
disabled, when 
paper is out. 

Paper Jam Set sending a Trap, 
enabled or 
disabled, when a 
paper jam occurs.

Location Comments
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Printer Trap 
Setup . . .

Detail . . . Cover Open Set sending a Trap, 
enabled or 
disabled, when the 
printer cover 
opens. 

Printer Error Set sending a Trap, 
enabled or 
disabled, when any 
errors occur. 

Location Comments
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E-Mail (Send) Tab

In E-Mail Tab, you can configure SMTP related items.      

    bmp34.jpg   
   

Location Comments

Use SMTP 
Transmit Protocol

Set sending E-mail via SMTP, enabled or disabled. 

SMTP Server 
Name

Set Server name.

Priinter E-mail 
Address

Set the E-mail address that is used in the [From] field in 
the mail header.  

Destination 
Address 1 - 5

Set E-mail addresses to where E-mail should be send. 
Up to five E-Mail addresses can be set. 

Set Notify Mode.

Set Event Mode.
Attach Info Set information to attach.
Authentication Set User ID and Password.
Comments Add comments
Others Set SMTP port number and Reply-To address
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SMTP Tab

In SMTP Tab, you can configure SMTP related items.      

    bmp34.jpg   

Location Comments

Use SMTP 
Transmit Protocol

Set sending E-mail via SMTP, enabled or disabled. 

NTP Server 1 
Address

Set Server 1 address.

NTP Server 2 
Address

Set Server 2 address. 

Adjust Interval Set interval that OkiLAN checks specified events: 1, 12, 
or 24 hours.

Local Time Zone Set time.
Daylight Saving Set Daylight Saving time.
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Maintenance Tab

In Maintenance Tab, you can configure the following:      

Location Comments

LAN Scale Set LAN Scale (normal/small)
IP Filter Setup   Detail... By selecting the button, the 

following items can be configured:

Configuration
Admin IP address
IP Address Range

Start/End 
Address

Printing

Service Detail... By selecting the button, you can 
setup the following service: 
Use TCP/IP Protocol
Use NetBEUI Protocol
Use FTP Service
UseTelnet Service
Use Web Service
Use IPP Service
Use SNMP Service
Use SMTP Transmit
Use encrypted communidation for 
configuration data
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IP Address Setup

If you only use TCP/IP and the OkiLAN has not yet been configured, 
occasionally it may not be displayed on AdminManager. You can 
configure the IP address of the OkiLAN by this function.

1. Select [IP Address Setup] from the [Setup] menu.

2. Set [Ethernet Address] and [IP Address] and select [OK].

      bmp42.jpg  

> The Ethernet Address (MAC address) is displayed during the 
self-diagnostic test.

3. AdminManager asks whether you want to initialize the 
network interface card or not. Select [Yes]. Even if you 
select [No] here, the IP address that you set can be used 
after turning the printer OFF and ON. The requirement to 
turn your printer OFF and ON is dependent on the network 
interface card.
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Configuration - 40



Option Menu

In the [Option] menu, the following item can be selected:

 

Item Function

Use TCP/IP 
Protocol

If this item is selected, AdminManager uses TCP/IP 
protocol to search/configure network interface cards.

Use IPX/SPX 
Protocol

If this item is selected, AdminManager uses IPX/SPX 
protocol to search/configure network interface cards.

Environment 
Setup

TCP/IP Tab

  bmp50.jpg

Set broadcast addresses that are 
used to search OKI network interface 
cards using the TCP/IP protocol. If 
[Use TCP/IP protocol] is unchecked, 
the search will not be carried out 
using TCP/IP.

NetWare Tab
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Set network addresses that are used 
to search OKI network interface cards 
via NetWare protocol. If there any 
many NetWare file servers on your 
network, specify the network address 
to which the network card belongs. If 
[Use NetWare protocol] is unchecked, 
the search will not be carried out 
using NetWare, but if [Auto Search] is 
selected, AdminManager will search 
all networks that AdminManager can 
detect.

SNMP Tab Obtain the printer name via SNMP; 
Set Community Name.

TimeOut Tab
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[Search Every]: Set response waiting 
time from a network card in seconds.

[Time Out]: Set time out between 
AdminManager and the network 
interface card in seconds.

[Retry]: Set how many times the 
retry will be carried out between 
AdminManager and the network 
interface card.
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Help Menu

In the [Help] menu, [About] is available as well as revision 
information for AdminManager.
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Using TELNET

The OkiLAN can be configured using TELNET. TELNET requires the 
OkiLAN to have a valid IP address configured. If the NIC already 
has an IP address configured, skip steps one to three below.  

> Note: Please ensure that a valid IP address for you network 
environment is used. Use of an incorrect IP address can cause 
serious problems on your network.

The following explanation uses Sun Solaris 2.4 as an example. The 
method of configuring commands may differ between 
workstations. Refer to the workstation’s manual.

1. Login as [root]. 

If you do not have Superuser rights, the network manager should 
run the configuration. 

2. Set a temporary IP Address on the NIC using the ARP 
command.

Example: for IP address 172.168.20.127 and network card address 
00:80:92:01:00:D2

# arp –s 172.168.20.127 00:80:92:01:00:D2 temp

The Ethernet address (MAC address) is displayed during the 
self-diagnostic test. A temporary address does not need to be set 
if an IP address has already been set.

3. Use the PING command to confirm the connection with the 
network card.

Example: for IP address 172.168.20.127

# ping 172.168.20.127

If there is no reply, there is a problem with the configuration of the 
IP address (the IP address has been already set manually or by the 
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DHCP/RARP server), or with the network. Reset the network 
interface card settings to default and try to set temporary IP 
address. If you still have the problem after resetting the network 
interface card, consult the network manager.

4. Login to the network card using TELNET.

Example: for IP address 172.168.20.127

$ telnet 172.168.20.127

Trying 172.168.20.127

Connected to 172.168.20.127

Escape character is ‘^]’.

EthernetBoard OkiLAN PRINTER".

login: root

‘root’ user needs password to login.

password:

User ‘root’ logged in.

No. Message Value (level.1)

------------------------------------

 1:  Setup TCP/IP

 2:  Setup SNMP

 3:  Setup NetWare

 4:  Setup EtherTalk

 5:  Setup NetBEUI

 6:  Setup printer port

 7:  Display Status
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 8:  Setup printer trap

 9:  Setup SMTP (E-Mail)

97:  Reset to factory set

98:  Quit setup

99:  Exit setup

Please select (1-99)?

5. Enter the number of the items to be changed and the details 
screen for that item is displayed. The menu has the 
following hierarchical structure so for more details see the 
description in the appropriate numbers
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Telnet hierarchical structure

Level1 Level2 Level3 Ref No.

1: Setup TCP/IP 1:  TCP/IP protocol — TCPIP-1

2:  IP address — TCPIP-2

3: Subnet — TCPIP-3

4: Gateway — TCPIP-4

5: RARP protocol — TCPIP-5

6: DHCP/BOOTP 
protocol

— TCPIP-6

7:  DNS server(Pri.) — TCPIP-7

8:  DNS server(Sec.) — TCPIP-8

9: Root password — TCPIP-9

99: Back to prior menu — —

2: Setup SNMP 1: Authentic 
community

— SNMP-1

2:  Trap community — SNMP-2

3:  Trap address — SNMP-3

4: SysContact — SNMP-4

5:  SysName — SNMP-5

6:  SysLocation — SNMP-6

7:  DefaultTTL — SNMP-7

8:  EnableAuthenTrap — SNMP-8

99: Back to prior menu — —
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3: Setup NetWare 1:  NetWare protocol — NetWare-1

2:  Packet type — NetWare-2

3:  NetWare mode — NetWare-3

4:  Setup PSERVER   
mode

1:  FSERVER name 1 NetWare-3

2:  FSERVER name 2 NetWare-4

3:  FSERVER name 3 NetWare-4

4:  FSERVER name 4 NetWare-4

5:  FSERVER name 5 NetWare-4

6:  FSERVER name 6 NetWare-4

7:  FSERVER name 7 NetWare-4

8:  FSERVER name 8 NetWare-4

9:  Machine name NetWare-5

10: Password NetWare-6

11: Job polling interval NetWare-7

12: Bindery mode NetWare-8

13: NDS tree NetWare-9

14: NDS context NetWare-10

99:  Back to prior menu —

3:Setup Netware 5: Setup RPRINTER 
mode

1:  PSERVER name 1 NetWare-11

2:  PSERVER name 2 NetWare-11

3:  PSERVER name 3 NetWare-11

4:  PSERVER name 4 NetWare-11

5:  PSERVER name 5 NetWare-11

6:  PSERVER name 6 NetWare-11

7:  PSERVER name 7 NetWare-11

8:  PSERVER name 8 NetWare-11

9: Job timeout NetWare-12

99:Back to prior menu —

99: Back to prior menu — —

4: Setup EtherTalk 1:  EtherTalk protocol — EtherTalk-1

2:  Zone name — EtherTalk-2

99: Back to prior menu — —

5: Setup NetBEUI 1:  NetBEUI protocol — NetBEUI-1

2:  Computer name — NetBEUI-2

3: Workgroup name — NetBEUI-3

4: Comment — NetBEUI-4

99: Back to prior menu — —

Level1 Level2 Level3 Ref No.
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6: Setup printer 
port

1:  NetWare port name — Port-1

2: EtherTalk port name — Port-2

3:  BOJ string — Port-3

4:  EOJ string — Port-4

5:  BOJ string(KANJI) — Port-5

6:  EOJ string(KANJI) — Port-6

7:  Printer type — Port-7

8: TAB size (char.) — Port-8

9:  Page width (char.) — Port-9

10: Page length(line) — Port-10

11: lpr/ftp banner — Port-11

99: Back to prior menu — —

7: Display status 1:  prn1 — STATUS-1

2: system — STATUS-2

8: Setup printer 
trap

1: Prn-Trap community — Trap-1

2: Setup TCP#1 trap
3: Setup TCP#2 trap
4: Setup TCP#3 trap
5: Setup TCP#4 trap

1: TCP#1—5 Trap enable Trap-2

2: On-line trap Trap-3

3: Off-line trap Trap-4

4: Paper Out trap Trap-5

5: Paper Jam trap Trap-6

6: Cover Open trap Trap-7

7:  Printer Error trap Trap-8

8: TCP#1—5 Trap 
address

Trap-9

99: Back to prior menu —

 7: Setup IPX   trap 1: IPX   Trap enable Trap-10

2: On-line trap Trap-11

3: Off-line trap Trap-12

4: Paper Out trap Trap-13

5: Paper Jam trap Trap-14

6: Cover Open trap Trap-15

7: Printer Error trap Trap-16

8: IPX   Trap address Trap-17

9: IPX   Trap net Trap-18

99: Back to prior menu —

99: Back to prior menu — —

Level1 Level2 Level3 Ref No.
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8. When configuration is complete, select [Exit Setup] to save 
your change. To exit without saving your modification, select 
[Quit]. 

9: Setup SMTP 
(E-Mail)

1: SMTP Transmit — SMTP-1

2: SMTP Receive — SMTP-2

3: SMTP server name — SMTP-3

4: SMTP port number — SMTP-4

5: E-Mail address — SMTP-5

6: Reply-to address — SMTP-6

7: Event to address 1
8: Event to address 2
9: Event to address 3
10: Event to address 4
11: Event to address 5

1: To Address 1—5 SMTP-7

2:  Re-send Interval SMTP-8

3: Off-Line SMTP-9

4: Consumable Message SMTP-10

5: Toner Low/Out SMTP-11

6: Paper Low/Out SMTP-12

7: Paper Jam SMTP-13

8:  Cover Open SMTP-14

9: Stacker Error SMTP-15

10: Mass Storage Error SMTP-16

11: Recoverable Error SMTP-17

12: Service Call Req. SMTP-18

13: Finisher SMTP-19

99: Back to prior menu —

9: Setup SMTP 
(E-Mail)

12: Signature line 1
13: Signature line 2
14: Signature line 3
15: Signature line 4

— SMTP-20

99: Back to prior menu — —

10: Setup POP 
(E-Mail)

1: POP3 protocol — POP-1

2: POP3 server — POP-2

3: POP port number — POP-3

4: POP3 server UserID — POP-4

5: POP3 server 
Password

— POP-5

6: Use APOP — POP-6

7: Retrieve every 
(min.)

— POP-7

99: Back to prior menu — —

97: Reset to factory 
set

— — ETC-1

98: Quit setup — — —
99: Exit setup — — —

Level1 Level2 Level3 Ref No.
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9. Turn the printer off and on again.

The network card continues to use pre-transmission settings until 
the printer is turned off and back on again. 
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Using SNMP
The printer and network card can be managed via a standard SNMP 
management station. The network card supports SNMPv1, MIB-II 
and OKI Data Private MIB.

The printer’s trap address can be set in five places using TCP/IP 
and in one place with IPX.

The printer’s trap address can be set in five places using TCP/IP 
and in one place with IPX.

Printer trap settings can be made with TELNET and a Web browser.

Configurable items and Default Values

Bold is the default setting.

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes

TCPIP-1 [OKI Device 
Setup]-
[TCP/IP]-
[Use TCP/IP 
Protocol]

[Network 
Configuration]-[
General 
Settings]-[Protoc
ol Options]-[TCP/
IP]

[Setup TCP/
IP]-
[TCP/IP 
protocol]

ENABLE/
DISABLE

Set TCP/IP 
protocol, 
enabled/
disabled

TCPIP-2 [OKI Device 
Setup]-
[TCP/IP]-
[IP Address]

[Network 
Configuration]-[T
CP/IP]-[Fixed IP 
Address 
Settings]-[IP 
Address]

[Setup TCP/
IP]-[IP addres
s]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set IP 
address

TCPIP-3 [OKI Device 
Setup]-
[TCP/
IP]-[Subnet 
Mask]

[Network 
Configuration]-[T
CP/IP]-[Fixed IP 
Address 
Settings]-[Subne
t Mask]

[Setup TCP/
IP]-[Subnet 
mask]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set subnet 
mask

TCPIP-4 [OKI Device 
Setup]-
[TCP/
IP]-[Default 
Gateway]

[Network 
Configuration]-[T
CP/IP]-[Fixed IP 
Address 
Settings]-[Defaul
t Gateway]

[Setup TCP/
IP]-[Gateway 
address]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set 
gateway 
(default 
route).
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TCPIP-5 [OKI Device 
Setup]-
[TCP/IP]-
[Use RARP]

[Network 
Configuration]-[T
CP/IP]-[Method 
for assigning IP 
Address]-[RARP]

[Setup TCP/
IP]-[RARP 
protocol]

ENABLE/
DISABLE

SET RARP 
function, 
enabled/
disabled

TCPIP-6 [OKI Device 
Setup]-[TCP
/IP]-[Use 
DHCP/
BOOTP]

[Network 
Configuration]-[T
CP/IP]-[Method 
for assigning IP 
Address]-[DHCP/
BOOTP]

[Setup TCP/
IP]-[DHCP/
BOOTP 
protocol]

ENABLE/
DISABLE

Set DHCP 
function, 
enabled/
disabled

TCPIP-7 [OKI Device 
Setup]-
[TCP/IP]-
[DNS 
Server...]
-[Primary 
Server]

[Network 
Configuration]-[T
CP/IP]-[Fixed IP 
Address 
Settings]-[DNS 
Server Address 
(Pri.)] 

[Setup TCP/
IP]-
[DNS 
server(Pri.)]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set IP 
address for 
primary 
DNS server

TCPIP-8 [OKI Device 
Setup]
-[TCP/IP]-
[DNS 
Server...]
-[Secondary 
Server]

[Network 
Configuration]-[T
CP/IP]-[Fixed IP 
Address 
Settings]-[DNS 
Server Address 
(Sec.)]

[Setup TCP/
IP]-[DNS 
server(Sec.)]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set IP 
address for 
secondary 
DNS server

TCPIP-9 [OKI Device 
Setup]-[Gen
eral]-[Chan
ge root 
password]

[Setup TCP/
IP]-
[root 
password]

Any 
alphanumeric 
characters up
to seven 
characters. 
(Default is null)

Set the root 
password of 
OkiLAN 

SNMP-1 [OKI Device 
Setup]-[SN
MP]-[Authe
ntic 
Community]

[Network 
Configuration]-[
SNMP Traps]-
[MIB-II 
Information]-[Au
thentic 
Community]

[Setup 
SNMP]-[Authe
ntic 
community]

Any 
alphanumeric 
characters up to 
15 characters. 
(Default is 
[public])

This 
community 
name is 
used to 
check 
whether 
incoming 
SNMP 
requests 
have the 
correct 
community 
name or 
not. The 
community 
name is 
displayed 
as ****** 
for security 
reasons

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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SNMP-2 [OKI Device 
Setup]-[SN
MP]-[TRAP 
Community]

[Network 
Configuration]-[
SNMP Traps]-
[MIB-II 
Information]-
[Trap 
Community]

[Setup SNMP]-
[Trap 
community]

Any 
alphanumeric 
characters up to 
15 characters. 
(Default is 
[public])

This 
community 
name is 
assigned to 
outgoing 
system 
traps such 
as cold 
start, 
authenti-ca
tion failure, 
etc.

SNMP-3 [OKI Device 
Setup]-[SN
MP]-
[TRAP 
Address]

[Network 
Configuration]-[
SNMP Traps]-
[MIB-II 
Information]-
[Trap IP Address]

[Setup SNMP]-
[Trap address]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set a 
destination 
IP address 
of Trap 
packet. If 
0.0.0.0 is 
set, Trap is 
disabled

SNMP-4 [OKI Device 
Setup]-[SN
MP]-[SysCo
ntact]

[Network 
Configuration]-[
General 
Settings]-[Syste
m 
Information]-[Sy
stem Contact]

[Setup 
SNMP]-[SysCo
ntact]

Any 
alphanumeric 
characters up to 
255 characters. 
(Default is null)

Set 
SysContact 
(printer 
manager) 
name

SNMP-5 [OKI Device 
Setup]-[SN
MP]-[SysNa
me]

[Network 
Configuration]-[
General 
Settings]-[Syste
m Information]- 
[System Name]

[Setup 
SNMP]-[SysNa
me]

Any 
alphanumeric 
characters up to 
255 characters. 
(Default is null)

Set 
SysName 
(printer 
model 
name) 

SNMP-6 [OKI Device 
Setup]-[SN
MP]-[SysLoc
ation]

[Network 
Configuration]-[
General 
Settings]-[Syste
m Information]- 
[System 
Location]

[Setup 
SNMP]-[SysLo
cation]

Any 
alphanumeric 
characters up to 
255 characters. 
(Default is null)

Set 
Sys-Locatio
n (the 
location 
where the 
printer is 
installed)

SNMP-7 [OKI Device 
Setup]-[SN
MP]-[Defaul
t TTL]

[Setup 
SNMP]-[Defaul
tTTL]

0—255 Set TTL 
(Time To 
Live) value

SNMP-8 [OKI Device 
Setup]-[SN
MP]-[Enable 
Authen 
Trap]

[Network 
Configuration]-[
SNMP Traps]-
[MIB-II 
Information]-[En
able 
AuthenTraps]

[Setup 
SNMP]-[Enabl
eAuthenTrap]

1 (Enable)/
2 (Disable) 

Set 
Authentic 
Trap, 
enabled/
disabled

Ref. No. Admin 
Manager
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Diagnostic 
test print

Available 
options
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NetWare-1 [OKI Device 
Setup]-[Net
Ware]-[Use 
NetWare 
Protocol]

[Network 
Configuration]-[
General 
Settings]-[Protoc
ol 
Options]-[NetWa
re]

[Setup 
NetWare]-[Net
Ware protocol]

ENABLE/
DISABLE

Set 
NetWare 
protocol, 
enabled/
disabled

NetWare-2 [OKI Device 
Setup]-[Net
Ware]-[Fra
me Type]

[Network 
Configuration]-[
General 
Settings]-[Frame 
Options]-[NetBE
UI]

[Setup 
NetWare]-[Pac
ket type]

ETHER-II/802.3/
802.2/SNAP/
AUTO

Set primary 
NetWare 
packet type

NetWare-3 [OKI Device 
Setup]-[Net
Ware]-[Ope
ration 
Mode]

[Network 
Configuration]-[
NetWare]-[NetW
are 
Selections]-[Net
Ware Mode]

[Setup 
NetWare]-[Net
Ware mode]

RPRINTER/
PSERVER

Set 
NetWare 
mode

NetWare-4 [OKI Device 
Setup]-[Net
Ware]-[Bind
ery 
Setup]-[Sel
ected file 
server]

[Network 
Configuration]-[
NetWare]-[File 
Server for 
PServer 
Mode]-[File 
Server Names]

[Setup 
NetWare]-[Set
up PSERVER 
mode]– 
[FSERVER 
name 1—8]

Any 
alphanumeric 
characters up to 
47 characters. 
(Default is null)

Set file 
servers to 
connect. 
Up to eight 
file servers 
can be set. 
If you have 
nine or 
more file 
servers, 
you should 
set file 
servers 
here

NetWare-5 [OKI Device 
Setup]-[Net
Ware]-[Print 
Server 
Name]

[Network 
Configuration]-[
NetWare]-[PServ
er 
Mode]-[NetWare 
Print Server 
Name]

[Setup 
NetWare]-[Set
up PSERVER 
mode]– 
[Machine 
name]

Any 
alphanumeric 
characters up to 
31 characters. 
(Default is [OL] 
+ last six 
digits of MAC 
address)

Set Print 
Server 
name

NetWare-6 [OKI Device 
Setup]-[Net
Ware]-[Bind
ery 
Setup]-[Pas
sword]

[Network 
Configuration]-[
NetWare]-[PServ
er 
Mode]-[Password
]

[Setup 
NetWare]-[Set
up PSERVER 
mode]– 
[Password]

Any 
alphanumeric 
characters up to 
31 characters. 
(Default is null)

Set 
password 
for Print 
Server

NetWare-7 [OKI Device 
Setup]-[Net
Ware]-[Bind
ery 
Setup]-[Job 
Polling 
Time]

[Network 
Configuration]-[
NetWare]-[PServ
er Mode]-[Job 
Polling Rate]

[Setup 
NetWare]-[Set
up PSERVER 
mode]– [Job 
polling 
interval]

2—255 (4) Set print 
job polling 
interval in 
seconds

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options
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NetWare-8 [OKI Device 
Setup]-[Net
Ware]-[Bind
ery Setup]

[Network 
Configuration]-[
NetWare]-[PServ
er 
Mode]-[Bindery 
Mode]

[Setup 
NetWare]-[Set
up PSERVER 
mode]–
[Bindery 
mode]

ENABLE/
DISABLE

Set bindery 
mode, 
enabled/
disabled. 
Set 
DISABLE if 
you use 
OkiLAN as 
PSERVER 
on NDS

NetWare-9 [OKI Device 
Setup]-[Net
Ware]-[NDS 
Setup]-[ND
S Tree]

[Network 
Configuration]-[
NetWare]-[NDS]
-[Tree Name]

[Setup 
NetWare]-[Set
up PSERVER 
mode] – [NDS 
tree]

Any 
alphanumeric 
characters up to 
31 characters. 
(Default is null)

Set NDS 
Tree name

NetWare-10 [OKI Device 
Setup]-[Net
Ware]-[NDS 
Setup]-[ND
S Context]

[Network 
Configuration]-[
NetWare]-[NDS]
-[Context]

[Setup 
NetWare]-[Set
up PSERVER 
mode] – [NDS 
context]

Any 
alphanumeric 
characters up to 
77 characters. 
(Default is null)

Set NDS 
context for 
Print Server

NetWare-11 [OKI Device 
Setup]-[Net
Ware]-[RPR
INTER 
Setup]-[Sel
ected print 
server]

[Network 
Configuration]-[
NetWare]-[Remo
te Printer 
Mode]-[NetWare 
Print Server 
Names]

[Setup 
NetWare]-[SE
T RPRINTER 
mode] – 
[PSERVE name 
1—8]

Any 
alphanumeric 
characters up to 
47 characters. 
(Default is null)

Set print 
servers to 
connect. 
Up to eight 
print 
servers can 
be set.
If you have 
nine or 
more print 
servers, 
you should 
set print 
servers 
here

NetWare-12 [OKI Device 
Setup]-[Net
Ware]-[RPR
INTER 
Setup]-[Tim
e Out]

[Network 
Configuration]-[
NetWare]-[Remo
te Printer Mode]-
[Job Timeout]

[Setup 
NetWare]-[SE
T RPRINTER 
mode]–[Job 
timeout]

4—255 (10) Set 
duration 
from the 
last data’s 
arrival to 
freeing the 
port in 
seconds

EtherTalk-1 [OKI Device 
Setup]-[Eth
erTalk]-[Use 
EtherTalk 
Protocol]

[Network 
Configuration]-[
General 
Settings]-[Protoc
ol 
Options]-[EtherT
alk]

[Setup 
EtherTalk]-[Et
herTalk 
protocol]

ENABLE/
DISABLE

Set 
EtherTalk, 
enabled or 
disabled

EtherTalk-2 [OKI Device 
Setup]-[Eth
erTalk]-[Zon
e Name]

[Network 
Configuration]-[E
therTalk]-[EtherT
alk Zone Name]

[Setup 
EtherTalk]-[Zo
ne name]

Any 
alphanumeric 
characters up to 
32 characters. 
([*])

Set Zone 
Name to 
which 
OkiLAN 
belongs.

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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NetBEUI-1 [OKI Device 
Setup]-[Net
BEUI]-[Use 
NetBEUI 
Protocol]

[Network 
Configuration]-[
General 
Settings]-[Protoc
ol 
Options]-[NetBE
UI]

[Setup 
NetBEUI]-[Net
BEUI protocol]

ENABLE/
DISABLE

Set 
NetBEUI, 
enabled or 
disabled.

NetBEUI-2 [OKI Device 
Setup]-[Net
BEUI]-[Com
puter 
Name]

[Network 
Configuration]-[
NetBEUI]-[NetBE
UI]-[Computer 
Name]

[Setup 
NetBEUI]-[Co
mputer name]

Any 
alphanumeric 
characters up to 
15 characters. 
(Default is [OL] 
+ last six 
digits of MAC 
address)

Set a 
computer 
name for 
OkiLAN.

NetBEUI-3 [OKI Device 
Setup]-[Net
BEUI]-[Wor
kgroup]

[Network 
Configuration]-[
NetBEUI]-[NetBE
UI]-[Workgroup 
Name]

[Setup 
NetBEUI]-[Wo
rkgroup name]

Any 
alphanumeric 
characters up to 
15 characters. 
(Default is 
[PrintServer])

Set a work- 
group name 
to which 
OkiLAN 
belongs.

NetBEUI-4 [OKI Device 
Setup]-[Net
BEUI]-[Com
ment]

[Network 
Configuration]-[
NetBEUI]-[NetBE
UI]-[Comment]

[Setup 
NetBEUI]-[Co
mment]

Any 
alphanumeric 
characters up to 
48 characters. 
(Default is 
[EthernetBoar
d OkiLAN])

Set the 
comments 
for OkiLAN.

Port-1 [OKI Device 
Setup]-[Net
Ware]-[Print
er Name]

[Network 
Configuration]-[
NetWare]-[NetW
are 
Selections]-[Net
Ware Printer 
Name]

[Setup printer 
port]-[NetWar
e port name]

Any 
alphanumeric 
characters up to 
31 characters. 
(Default is [OL] 
+ last six 
digits of MAC 
address + 
-prn1])

Set 
NetWare 
printer 
object 
name

Port-2 [OKI Device 
Setup]-[Eth
erTalk]-[Prin
ter Name]

[Network 
Configuration]-[E
therTalk]-[EtherT
alk Printer 
Name]

[Setup printer 
port]-[EtherTal
k port name]

Any 
alphanumeric 
characters up to 
32 characters.
(Default is the 
printer name 
on which 
OkiLAN is 
installed) 

Set 
EtherTalk 
printer 
object 
name

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options
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Port-3 [Setup printer 
port]-[BOJ 
string]

Any 
alphanumeric 
and following 
control 
characters up to 
31 characters. 
(Default is null).
\b Backspace 
(0x08)
\t Tab (0x09)
\n Linefeed 
(0x0a)
\v Vertical tab 
(0x0b)
\f Page feed 
(0x0c)
\r Carriage 
return (0x0d)
\xnn Hex code 
[nn] (0xnn)
\] Double quote 
(0x22)
\\ Backslash 
(0x5c)

Set an 
appropriate 
command 
sequence to 
be sent to 
the 
connected 
printer 
before 
printing job

Port-4 [Setup printer 
port]-[EOJ 
string]

Any 
alphanumeric 
and following 
control 
characters up to 
31 characters. 
(Default is null)
\b Backspace 
(0x08)
\t Tab (0x09)
\n Linefeed 
(0x0a)
\v Vertical tab 
(0x0b)
\f Page feed 
(0x0c)
\r Carriage 
return (0x0d)
\xnn Hex code 
[nn] (0xnn)
\] Double quote 
(0x22)
\\ Backslash 
(0x5c)

Set an 
appropriate 
command 
sequence to 
be sent to 
the 
connected 
printer after 
printing job

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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Port-5 [Setup printer 
port]-[BOJ 
string(KANJI)]

Any 
alphanumeric 
and following 
control 
characters up to 
31 characters. 
(Default is null)
\b Backspace 
(0x08)
\t Tab (0x09)
\n Linefeed 
(0x0a)
\v Vertical tab 
(0x0b)
\f Page feed 
(0x0c)
\r Carriage 
return (0x0d)
\xnn Hex code 
[nn] (0xnn)
\] Double quote 
(0x22)
\\ Back slash 
(0x5c)

Set an 
appropriate 
command 
sequence to 
be sent to 
the 
connected 
printer 
before 
printing job 
when data 
is sent to 
sjis/euc 
logical 
printer/
directory

Port-6 [Setup printer 
port]-[EOJ 
string(KANJI)]

Any 
alphanumeric 
and following 
control 
characters up to 
31 characters. 
(Default is null)
\b Backspace 
(0x08)
\t Tab (0x09)
\n Linefeed 
(0x0a)
\v Vertical tab 
(0x0b)
\f Page feed 
(0x0c)
\r Carriage 
return (0x0d)
\xnn Hex code 
[nn] (0xnn)
\] Double quote 
(0x22)
\\ Back slash 
(0x5c)

Set an 
appropriate 
command 
sequence to 
be sent to 
the 
connected 
printer after 
printing job 
when data 
is sent to 
sjis/euc 
logical 
printer/
directory

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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Port-7 [Setup printer 
port]-[Printer 
type]

PS Set a 
printer type 
when data 
is sent to 
sjis/euc 
logical 
printer/
directory

Port-8 [Setup printer 
port]-[TAB 
size (char.)]

0—16 (8) Set tab size 
when data 
is sent to 
sjis/euc 
logical 
printer/
directory. 
The value 0 
does not 
convert any 
tabs

Port-9 [Setup printer 
port]-[Page 
width (char.)]

0—255 (78) Set page 
width when 
data is sent 
to sjis/euc 
logical 
printer/
directory. If 
the width of 
one line 
exceeds 
this value, 
Carriage 
Return and 
Line Feed 
are inserted 
automatical
ly. The 
value 0 
means no 
limitation of 
the line 
width

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options
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Port-10 [Setup printer 
port]-[Page 
length(line)]

0—255 (66) Set page 
length 
when data 
is sent to 
sjis/euc 
logical 
printer/
directory.
If the 
number of 
lines 
exceeds 
this value, 
Form Feed 
are inserted 
automatical
ly. The 
value 0 
means no 
limitation of 
the line 
width

Port-11 [OKI Device 
Setup]-[TCP
/IP]-[Use 
FTP/LPD 
Banner]

[Setup printer 
port]-[lpr/ftp 
banner]

NO/YES Set banner 
printing for 
LPR/FTP 
enabled/
disabled

STATUS-1 [Status]-[Pr
inter 
Status]

[Printer Status] [Display 
status]-[prn1]

Display 
logical port 
status

STATUS-2 [Setup]-[Sy
stem 
Status]

[Network 
Configuration]-[
Network 
Summary]

[Display 
status]-[syste
m]

Display 
system 
status

Trap-1 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. . ]-[Printer 
Trap 
Community 
Name]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Destination]-[Pri
nter Trap 
Community 
Name]

[Setup printer 
trap]-[Prn-Tra
p community]

Any 
alphanumeric 
characters up to 
77 characters. 
(Default is 
[public])

This 
community 
name is 
assigned to 
outgoing 
printer 
status traps 
such as 
off-line, 
paper out, 
etc.

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options
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Trap-2 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Trap 
Enable]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[Tr
ap Enable]

[Setup printer 
trap]-
[Setup 
TCP#1—5 
trap] – 
[TCP#1—5 
Trap enable]

ENABLE/
DISABLE

Set sending 
a trap 
packet 
enabled or 
disabled for 
each 
destination. 
Five IP 
address 
destinations 
can be set 
up and one 
IPX 
destination

Trap-3 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[On-line]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[O
n-line]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – 
[On-line trap]

ENABLE/
DISABLE

Set sending 
a trap, 
enabled or 
disabled, 
when the 
printer 
turns to 
ON-LINE

Trap-4 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Off-line]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[O
ff-line]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – 
[Off-line trap]

ENABLE/
DISABLE

Set sending 
a trap, 
enabled or 
disabled, 
when the 
printer 
turns to 
OFF-LINE

Trap-5 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Paper 
Out]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[P
aper Out]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – [Paper 
Out trap]

ENABLE/
DISABLE

Set sending 
a trap, 
enabled or 
disabled, 
when paper 
is out

Trap-6 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Paper 
Jam]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[P
aper Jam]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – [Paper 
Jam trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when a 
paper jam 
occurs

Trap-7 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Cover 
Open]

[Network 
Configuration]-[
SNMP 
Traps]-[Trap 
Assignments]-[C
over Open]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – [Cover 
Open trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when the 
printer 
cover opens

Ref. No. Admin 
Manager
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Diagnostic 
test print

Available 
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Trap-8 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5]-[Detail . . 
.]-[Printer 
Error]

[Network 
Configuration]-[
SNMP 
Traps]-[Trap 
Assignments]-[P
rinter Error]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – 
[Printer Error 
trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when any 
errors occur

Trap-9 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. 
.]-[TCP#1—
5] 

[Network 
Configuration]-[
SNMP 
Traps]-[Trap 
Destination]-[Ad
dress 1]—
[Address 5]

[Setup printer 
trap]-[Setup 
TCP#1—5 
trap] – 
[TCP#1—5 
Trap address]

0.0.0.0—
255.255.255.25
5 (0.0.0.0)

Set IP 
address to 
which a 
trap packet 
will be sent. 
You can set 
up to five IP 
addresses

Trap-10 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Trap 
Enable]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[Tr
ap Enable]

[Setup printer 
trap]-
[Setup IPX 
trap] –
[IPX Trap 
enable]

ENABLE/
DISABLE

Set sending 
a trap 
packet 
enabled or 
disabled for 
each 
destination. 
You can set 
up to five IP 
address 
destinations 
and one IPX 
destination.

Trap-11 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[On-line]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[O
n-line]

[Setup printer 
trap]-
[Setup IPX 
trap] – 
[On-line trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when the 
printer 
turns to 
ON-LINE

Trap-12 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Off-line]

[Network 
Configuration]-[
SNMP 
Traps]-[Trap 
Assignments]-
[Off-line]

[Setup printer 
trap]-[
Setup IPX 
trap] – 
[Off-line trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when the 
printer 
turns to 
OFF-LINE.

Trap-13 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Paper 
Out]

[Network 
Configuration]-[
SNMP 
Traps]-[Trap 
Assignments]-[P
aper Out]

[Setup printer 
trap]-
[Setup IPX 
trap] – [Paper 
Out trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when paper 
is out

Ref. No. Admin 
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test print

Available 
options

Notes
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Configuration - 62



Trap-14 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Paper 
Jam]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[P
aper Jam]

[Setup printer 
trap]-[Setup 
IPX trap] –
[Paper Jam 
trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when a 
paper jam 
occurs

Trap-15 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Cover 
Open]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[C
over Open]

[Setup printer 
trap]-
[Setup IPX 
trap] – [Cover 
Open trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when the 
printer 
cover opens

Trap-16 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]-
[Detail . . 
.]-[Printer 
Error]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Assignments]-[P
rinter Error]

[Setup printer 
trap]-
[Setup IPX 
trap] – 
[Printer Error 
trap]

ENABLE/
DISABLE

Set sending 
a trap 
enabled or 
disabled 
when any 
errors occur

Trap-17 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Destination]-[IP
X]

[Setup printer 
trap]-
[Setup IPX 
trap] – [IPX 
Trap address]

Any address 
(00000000000
)

Set node 
address to 
which a 
trap packet 
will be sent

Trap-18 [OKI Device 
Setup]-[SN
MP]-[Printer 
Trap Setup . 
. .]-[IPX]

[Network 
Configuration]-[
SNMP Traps]-
[Trap 
Destination]-[IP
X]

[Setup printer 
trap]-
[Setup IPX 
trap] – [IPX 
Trap net]

Any address 
(00000000)

Set network 
address to 
which a 
trap packet 
will be sent

SMTP-1 [OKI Device 
Setup]-[SM
TP]-
[Use SMTP 
Transmit 
Protocol]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Transmit 
Settings]-
[SMTP Transmit]

[Setup SMTP
(E-Mail)]-
[SMTP 
Transmit]

ENABLE/
DISABLE

Set sending 
E-mail via 
SMTP, 
enabled or 
disabled

SMTP-2 [OKI Device 
Setup]-[SM
TP]-
[Use SMTP 
Receive 
Protocol]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Receive 
Settings]-
[SMTP Receive]

[Setup SMTP
(E-Mail)]-
[SMTP 
Receive]

ENABLE/
DISABLE

Set 
receiving 
E-mail via 
SMTP, 
enabled or 
disabled. 

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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SMTP-3 [OKI Device 
Setup]-[SM
TP]-
[SMTP 
Server 
Address/
Name]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Transmit 
Settings]-
[SMTP Server]

[Setup SMTP
(E-Mail)]-
[SMTP server 
name]

0.0.0.0—
255.255.255.25
5 or host name 
up to 64 
characters. 
(Default is null)

Set IP 
address or 
host name 
of SMTP 
server

SMTP-4 [OKI Device 
Setup]-[SM
TP]-[Advanc
ed . . 
.]-[SMTP 
Port 
Number]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Transmit 
Settings]-
[SMTP Port 
Number]

[Setup SMTP
(E-Mail)]-
[SMTP port 
number]

1—65535 (25) Set port 
number of 
SMTP

SMTP-5 [OKI Device 
Setup]-[SM
TP]-[E-Mail 
Address]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Transmit 
Settings]-
[Printer Email 
Address]

[Setup SMTP
(E-Mail)]-
[E-Mail 
address]

Any 
alphanumeric 
characters up to 
78 characters. 
(Default is null)

Set the 
E-mail 
address 
that is used 
for [From] 
field in the 
mail header

SMTP-6 [OKI Device 
Setup]-[SM
TP]-[Reply-
To Address]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Transmit 
Settings]-
[Reply-To-Addres
s]

[Setup SMTP
(E-Mail)]-[Repl
y-To address]

Any 
alphanumeric 
characters up to 
78 characters. 
(Default is null)

Set the 
E-mail 
address 
that is used 
for 
[Reply-To] 
field in the 
mail header

SMTP-7 [OKI Device 
Setup]-[SM
TP]-[1—
5]-[To 
Address 1—
5]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Recipients]-[Ema
il Address 1]—
[Email Address 
5]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [To 
Address 1—5]

Any 
alphanumeric 
characters up to 
78 characters. 
(Default is null)

Set E-mail 
addresses 
to that 
E-mail 
should be 
sent. Up to 
five E-mail 
addresses 
can be set

SMTP-8 [OKI Device 
Setup]-[SM
TP]-[1—
5]-[Check 
Interval]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-
[Re-send 
Interval]

[Setup SMTP(
E-Mail)]-[Even
t to address 
1—5] – 
[Re-send 
Interval]

DISABLE/
30min/60min/
24hour

Set interval 
that the 
OkiLAN 
checks 
specified 
event(s). 
An E-mail is 
sent when 
specified 
event(s) 
occur when 
DISABLE is 
selected

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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SMTP-9 [OKI Device 
Setup]-[SM
TP]-[1—
5]-[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-
[Off Line]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Off 
Line]

ENABLE/
DISABLE

An E-mail is 
sent when 
the printer 
is Off- line if 
this is 
enabled

SMTP-10 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[C
onsumable 
Message]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – 
[Consumable 
Message]

ENABLE/
DISABLE

An E-mail is 
sent when 
maintenanc
e is 
required if 
this is 
enabled

SMTP-11 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[T
oner Low Toner 
Out]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Toner 
Low/Out]

ENABLE/
DISABLE

An E-mail is 
sent when 
toner(s) 
low/out 
occurs if 
this is 
enabled

SMTP-12 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[P
aper Low Paper 
Out]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Paper 
Low/Out]

ENABLE/
DISABLE

An E-mail is 
sent when 
paper low/
out occurs if 
this is 
enabled

SMTP-13 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[P
aper Jam]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Paper 
Jam]

ENABLE/
DISABLE

An E-mail is 
sent when a 
paper jam 
occurs if 
this is 
enabled

SMTP-14 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[C
over Open]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Cover 
Open]

ENABLE/
DISABLE

An E-mail is 
sent when 
the cover is 
opened if 
this is 
enabled

SMTP-15 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[S
tacker Error]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – 
[Stacker 
Error]

ENABLE/
DISABLE

An E-mail is 
sent when 
any stacker 
error occurs 
if this is 
enabled

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Configuration - 65



SMTP-16 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[M
ass Storage 
Error]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – [Mass 
Storage Error]

ENABLE/
DISABLE

An E-mail is 
sent when 
any mass 
storage 
error occurs 
if this is 
enabled

SMTP-17 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[R
ecoverable Error]

[Setup 
SMTP(E-Mail)]
-[Event to 
address 1—5] 
– [Recoverable 
Error]

ENABLE/
DISABLE

An E-mail is 
sent when 
any 
recoverable 
error occurs 
if this is 
enabled

SMTP-18 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[S
ervice Call 
Required] 

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – 
[Service Call 
Req.]

ENABLE/
DISABLE

An E-mail is 
sent when 
any service 
call request 
occurs if 
this is 
enabled

SMTP-19 [OKI Device 
Setup]-[SM
TP]-[1—5]- 
[Selected 
condition]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Alert 
Assignments]-[Fi
nisher Error]

[Setup SMTP
(E-Mail)]-[Eve
nt to address 
1—5] – 
[Finisher]

ENABLE/
DISABLE

An E-mail is 
sent when 
any finisher 
error occurs 
if this is 
enabled

SMTP-20 [OKI Device 
Setup]-[SM
TP]-[Advanc
ed . . 
.]-[Signatur
e]

[Network 
Configuration]-[E
mail 
Settings]-[Email 
Signature]-[Sign
ature line 1]—
[Signature line 
4]

[Setup SMTP
(E-Mail)]-[Sig
nature line 1—
4]

Any 
alphanumeric 
characters up to 
63 characters. 
(Default is null)

Set up to 
four 
signature 
lines. 
Signature is 
added to 
the bottom 
of an E-mail

ETC-1 [Setup]-[Re
set]

[Network 
Configuration]-[
General 
Settings]-[Restor
e Factory 
Defaults] 

Reset to 
factory set

Reset 
OkiLAN 
settings to 
factory 
default

ETC-2 [Network 
Configuration]-[
General 
Settings]-[Syste
m Information]- 
[Printer Serial 
Number]

Read only 
item. 
Printer 
serial 
number is 
displayed

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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Configurable items vary between printers.

ETC-3 [Network 
Configuration]-[
General 
Settings]-[Syste
m Information]- 
[Printer Asset 
Number]

Any 
alphanumeric 
characters up to 
8 characters. 
(Default is null)

Set a 
printer 
asset 
number

Ref. No. Admin 
Manager

Web browser TELNET/ 
Diagnostic 
test print

Available 
options

Notes
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Management Utility

PrintSuperVision

PrintSuperVision is a web-based application for managing printing 
devices connected to a network. It consists of two parts:

A web application based on Microsoft web server (Internet 
Information Server, IIS or Personal WEB Server, PWS), that 
provides the user interface.

A monitoring program (PrintSuperVisor) that runs all the time, 
collecting data and saving it in a database for statistical reports and 
sending E-mail alerts based on the saved configuration.

PrintSuperVision’s main functions are:

> Maintaining the list of printing devices and organising them in 
logical groups.

> Initially discovering and configuring printers connected to the 
network.

> Locating printers visually on maps.

> Monitoring devices over time and saving data for statistical 
reports.

> Sending email alerts when events occur that affect the 
functionality of printers.

> Creating statistical reports about usage of printers.

> Tracking maintenance data related to printers.

> Integrating with Oki Data’s on-line web support.
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System requirement

Windows

The main PrintSuperVision application can be installed in any of the 
following Windows systems.

   

While the PrintSuperVision application may work in Windows 95 
with PWS installed, PrintSuperVision may not install or work 
properly in some versions of Windows 95. However, as a client, 
Windows 95 is fully supported.

Microsoft does not officially support Windows Me-PWS in Windows 
Me. PrintSuperVision does not support this OS. Also, Microsoft no 
longer supports Peer Web Service. PrintSuperVision will not work 
with Peer Web Service.

Operating System Service 
Pack

Option 
Pack

IIS/PWS

Windows NT 4.0 
Workstation

6.0 4.0 PWS (Personal Web Server) 
available in NT 4.0 Option Pack 

Windows NT 4.0 
Server

5.0 4.0 IIS (Internet Information 
Server) 1.0

Windows XP Home/
Professional

— — IIS installed as an option. 
Available in the Windows XP CD

Windows 2000 
Professional

1.0 — Internet Service Manager 
included in the OS

Windows 2000 
Server/Advanced 
Server

1.0 — Internet Service Manager 
included in the OS

Windows 98 — — PWD (Included in Windows 98 
by default) 

PWS available in NT 4.0 Option 
Pack in Microsoft Web site

Windows 98 SE — — PWD (Included in Windows 98 
by default. PWS available in NT 
4.0 Option Pack in Microsoft 
Web site
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Supported Browsers

The browsers supported are:

Internet Explorer (IE) 4.01 and above.

Netscape Navigator 4.0 and above.

Opera 5.12 and above.

The PrintSuperVision application can be accessed from any 
Windows, Macintosh, Unix, or Linux desktop that supports any of 
the above-mentioned browsers.

While all the above browsers are supported, PrintSuperVision 
works best when used with Internet Explorer. When using the 
Netscape browser, do not select the option [Images off]. The 
hyperlinks may not work properly. Some versions of Netscape 
browser do not display the frames properly, and the [Back] button 
may not work correctly.

Supported Printers

PrintSuperVision provides general management information for 
OKI and non-OKI printers connected to the network. For OKI 
printers using OkiLAN print servers, additional details, reports and 
added features are available. 

While the printer properties are displayed in PrintSuperVision, only 
a few of the printer settings can be set. For setting any other 
printer settings, a hyperlink to the printer’s web page is provided 
in PrintSuperVision.
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Installation

To install the Print SuperVision utility

Note: You must be connected to the internet to download this 
utility.

WindowsXP/2000/NT4.0 requires administrator privileges.

1. Insert the CD-ROM provided with your printer into the 
CD-ROM drive. 

If the Menu Installer doesn’t start automatically, click 
Start→Run→Browse. Browse to your CD-ROM. Click 
Setup→Open→OK.

2. Select [Internet Downloads].

3. Select [PrintSuperVision].

4. Follow the on-screen instructions. In the [Edit Data] screen, 
you can specify a port number for PrintSuperVision (default 
80). 

5. When installation ends, the [Setup complete] screen is 
displayed. Click [Finish]. 

6. Now you should select 
[Start]-[Programs]-[PrintSuperVision]-[PrintSuperVision] or 
double-click the [PrintSuperVision] icon on the desktop for 
the PrintSuperVision server. 

7. For PrintSuperVision client, access [http://[the server IP 
address or host name]/PrintSuperVision] from the Web 
browser. If you change the port number you should add 
[:[port number]] such as [http://172.168.20.127/
PrintSuperVision:8080].

8. PrintSuperVision has an on-line help facility.
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Uninstallation

To uninstall PrintSuperVision, either 

> select [Start] → [Programs]→[PrintSuperVision]→[Uninstall 
PrintSuperVision], 

or

> from [Control Panel], select [Add/Remove Programs], select 
[PrintSuperVision] from the index window and click [Add/
Remove]. When the uninstallation is completed, close [Add/
Remove Programs]. 

In some cases, an empty [Okidat/PrintSuperVision/] directory may 
be left behind. Delete the directory manually.
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Printing Utility

OKI LPR

The OKI LPR Utility is a utility that allows printing data to printers 
connected to the network via TCP/IP. This utility is for use with 
Windows XP, Windows 2000, Windows Me, Windows 98, Windows 
95 and Window NT4.0.

The utility is for those OKI printers which support TCP/IP; it 
redirects printing data to the lpr port of the specified IP address.

System Requirement

Windows XP/2000/Me/98/95/NT4.0 with TCP/IP support.

To install the OKI LPR utility 

The OKI LPR utility requires that the TCP/IP protocol should be 
installed in your Windows system. To install the TCP/IP protocol 
into your Windows system consult your Windows manual. 

Windows XP/2000/NT4.0 requires administrator privileges.

1. Set up the printer driver by designating the output 
destination to [Local Printer (LPT1:)]. For information on 
setting up your printer driver, see the printer user manual.

2. Insert the CD-ROM provided with your printer into the 
CD-ROM drive. 

If the Menu Installer doesn’t start automatically, click 
Start→Run→Browse. Browse to your CD-ROM.  Click 
Setup→Open→OK.

3. Select [Optional Utilities].

4. Select [Install Direct Network Printing Utility (LPR)]

5. Click [Next] when the [Welcome] screen is displayed.
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6. Verify [Destination Folder] and [Spool Folder] and click 
[Next].

7. Check [Register in Startup] if you want automatic startup as 
Windows boots up. Check [Launch as minimized] if you want 
to startup in the Icon state and click [Next].

8. Verify the program folder name and click [Next]. The 
installation starts.

9. When the installation ends, the [Setup complete] screen is 
displayed. Check [Yes, I want to launch OKI LPR Utility now] 
and click [Finish]. Check [Yes, I want to view the ReadMe 
File] if you want to read  [Readme]. The OKI LPR utility 
starts.

10. Select [Add Printer] on the [Remote Print] menu.

11. Select [Printer] to accept the printer that has been added in 
the step 1.

12. Enter an IP address at [IP Address] and click [OK]. A printer 
is added to the main window.

Refer to the On-line Help for information on how to use the utility.
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Uninstallation

1. Stop the OKI LPR Utility.  Right-click the OKI LPR icon in the 
system tray and click [Exit].

2. Select [Start] → [Program] → [Okidata] → [OKI LPR Utility] → 
[Uninstall OKI LPR Utility] ([Start] → [All Programs] → 
[Okidata] → [OKI LPR Utility] → [Uninstall OKI LPR Utility] on 
WindowsXP).

3. Click [Yes] when the [Confirm File Deletion] dialogue is 
displayed. Deletion of the OKI LPR utility starts.

4. When the deletion has finished, the [Uninstall Complete] 
screen is displayed. Click [OK]. 

If a file that has been added after installation exists in the folder to 
install the OKI LPR utility or the folder to spool, you cannot delete 
the folder. Delete any unwanted files before running [Uninstall OKI 
LPR Utility].
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Microsoft Windows
Overview

This chapter provides guidelines on how to print over the network 
from various Microsoft Windows platforms. There are numerous 
ways of printing from Windows and the exact set-up will vary 
depending upon your environment. There are also numerous 
versions of Windows, which can be configured as either a client, 
server or both.

Although there are many variants of Windows, the principles of 
network printing are the same. Microsoft provides on-line help with 
all of their operating systems and this is a good reference point for 
the exact details of each configuration option within Windows.

The network printer supports the following protocols that can be 
used in conjunction with the Windows operating system:

> TCP/IP

> IPX (Novell NetWare)

> NetBEUI
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Installation of TCP/IP Protocol

There are a number of options available when printing using TCP/
IP for Windows. The following table lists the options:

1These functions are built into Windows and are displayed as options when using the Add Printer 
Wizard.

Although there are some differences in configuration options 
between the various Windows platforms, the procedure for printing 
using TCP/IP is the same.

1. Ensure that the TCP/IP protocol has been installed in 
Windows. This can be confirmed by checking the network 
settings from within the Control Panel. If TCP/IP has not 
been installed refer to the section below Installation of TCP/
IP protocol.

2. If not already configured, a suitable IP address, Subnet 
Mask and Gateway address should be configured. Please 
refer to the on-line help if necessary. It is vital that the IP 
address entered is unique and valid. Entering an incorrect IP 
address may cause severe network problems. Please check 
the address with the network administrator.

3. If your network environment uses domain names, DNS 
should be enabled and configured on your system. However, 
this step is not essential to enable network printing. 

4. Restart the operating system.

Windows Version Method

Win 95/98/Me OKI LPR Utility
NT 4.0 OKI LPR Utility

Microsoft LPR1

Windows 2000/ Windows XP OKI LPR Utility

Microsoft LPR1

Port 91001

IPP1
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Windows 95/98/Me

1. Click the [Start] button, select [Settings] and then click 
[Control Panel].

2. In the [Control Panel] double-click on the [Network] icon. 

3. In the [Network] dialogue box click  [Configuration Panel].

4. If the [Client for Microsoft Networks] is not listed, click 
[Add].

5. In the [Select Network Component Type] dialogue box, 
select [Protocol] then click [Add].

6. In the [Select Network Protocol] dialogue box, select 
[Microsoft] from the list of manufacturers, then select [TCP/
IP] from the list of network protocols, then click [OK]. 

7. The Windows installation CD-ROM may be required. Follow 
the remaining dialogue box prompts.

Windows NT 4.0

1. Click [Start], select [Settings] and then click [Control 
Panel].

2. Double-click the [Network] icon.

3. In the Network dialogue box, click the [Protocols] tab.

4. If the [TCP/IP Protocol] is not listed, click [Add]. 

5. In the [Select Network Protocol] dialogue box, select [TCP/
IP Protocol] and click [OK].

6. The Windows NT installation CD-ROM may be required. 
Follow the remaining dialogue box prompts. 
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 Windows 2000

1. Click the [Start] button, select [Settings] and then click  
[Network and Dial-up Connections]. 

2. Double-click the [Local Area Connection] icon. In the [Local 
Area Connection Status] dialogue box, click [Properties]. 

3. In the [Local Area Connection Properties] dialogue box, click  
[Install]. 

4. In the [Select Network Component Type] dialogue box, 
select [Protocol] and click [Add].

5. In the [Select Network Protocol] dialogue box, select [TCP/
IP Protocol] and click [OK].

6. Click [Close] button in the [Local Area Connection 
Properties] dialogue box. 

7. Click [Close]  in the [Local Area Connection Status] dialogue 
box. 

Windows XP

1. Click the [Start] button and select [Control Panel].

2. Select [Network and Internet Connection] and [Network 
Connection].

3. Double-click [Local Area Connection] and click [Properties] 
in the [Location Area Connection Status] dialogue box.

4. If the [Internet Protocol (TCP/IP)] is not listed, click 
[Install.].

5. In the [Select Network Component Type] dialogue box, 
select [Protocol] then click  [Add].

6. In the [Select Network Protocol] dialogue box, select 
[Internet Protocol (TCP/IP)] then click [OK].
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7. The Windows XP installation CD-ROM may be required. 
Follow the remaining dialogue box prompts. 

Once the protocol has been installed and configured in Windows, 
the next step is to configure the TCP/IP parameters in the network 
printer.
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Network printer IP address configuration

Use the Admin/Manager Standard Set-up Utility to configure the IP 
Address, Subnet Mask and Gateway.  

1. Connect the printer to the network and turn on. 

2. Place the Network Software Utilities disk (or the software CD 
provided with your printer) in the CD-ROM drive. The set-up 
utility starts automatically. If the set-up utility does not 
start, double-click on setup.exe in the Windows folder of the 
CD-ROM.

3. Select [Install Network Setup Utility].

4. Select the appropriate language.

5. Click [Next] on the Welcome screen.

6. If you agree to the User License Agreement, click [Next].

7. Select the appropriate print server, using the Ethernet 
address to identify it, and click [Next].

The Ethernet address (MAC Address) of the printer can be 
found on the self-diagnostic printout, which can be printed by 
pressing the push-button on the network card for two 
seconds and then releasing it. 

Do you use the TCP/IP protocol? 

When using lpr in UNIX and other TCP/IP environments, 
please select [Yes]. To use in a TCP/IP environment, an IP 
address should be assigned to the Ethernet board. 

If [Yes] has been selected and TCP/IP is the only working 
protocol and the IP address has not already been assigned, 
you can either obtain an IP address automatically or assign 
an IP address.
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When [Obtain an IP address automatically] is selected, the 
device IP address will be automatically assigned by the DHCP 
server. In an environment without a DHCP server, please 
assign the IP address manually. 

If you are assigning an IP address, you need to enter: 

> An IP address 

> Subnet mask

> Gateway address. 

8. Click [Next].

Do you use the NetWare protocol? 

Consult your network manager to ensure that the NetWare 
file server is properly installed and working on the network. 
Make sure that NetWare Client32 or IntranetWare Client is 
installed on your computer.

9. On selecting [Yes] you will be asked if [You set-up the queue 
from the Wizard]? 

Do you use the EtherTalk protocol? 

EtherTalk is the required protocol for printing data from the 
Macintosh environment.

Do you use the NetBEUI protocol? 

Using NetBEUI makes it easy to manage your OKI product 
and print within the network environment of Windows.

10. Confirm your configuration. If everything is correct, select 
[Execute] to apply the configuration. Set-up has now been 
completed. Select [Finish].
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Now that both Windows and the printer have been configured to 
use TCP/IP, the next step is to configure Windows to print to the 
network printer. 

Windows 95/98/Me 

When printing using TCP/IP, the Oki LPR utility is the only option to 
use. The following procedure should be used. 

When installing the driver, ensure it is installed as a local printer 
and not a network printer. Ensure the appropriate printer driver 
has been installed in Windows. 

Install the Oki LPR utility as described on page 73 of this manual 
and add the printer installed earlier. 

Windows NT 4.0

With Windows NT 4.0, you have two options for printing using TCP/
IP. They are:

> Oki LPR

> Microsoft LPR

In order to use Microsoft LPR, it must first be installed into your 
operating system.

NT 4.0 requires administrator privileges.

Oki LPR

Please follow the procedure described in the Windows 95/98/Me 
section on page 83.

Microsoft LPR

To install this port, the following needs to be carried out.

1. Select [Start], [Settings], [Control Panel] and then select 
[Printers].
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2. Select [Add Printer] Wizard.

3. Select [My Computer] and then [Next].

4. Select [Add Port].

5. Select [LPR Port] and then [OK].

6. In [Name or address of server providing lpd] type the host 
name or IP address of the host for the printer you are 
adding.

7. In [Name of printer or print queue on that server] type the 
logical printer name "lp" and then click [OK].

8. Follow the instructions on the screen to finish installing the 
LPR-compatible printer.

If the LPR port is not available, install the Microsoft TCP/IP Printing 
Service.

Insert the printer driver for Windows NT4.0.

1. Select [Start]→[Settings]→[Control Panel] and then 
double-click the [Network] icon.

2. In the Network dialogue box, click the [Services] tab.

3. If [Microsoft TCP/IP Printing] is not listed, click [Add].

4. In the [Select Network Service] dialogue box, select 
[Microsoft TCP/IP Printing] and click [OK].

5. The Windows NT installation CD-ROM may be required. 
Follow the remaining dialogue box prompts.
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Windows 2000 

Windows 2000 requires administrator privileges.

With Windows 2000, there are four options for printing using TCP/
IP.

> Oki LPR

> Microsoft LPR

> Port 9100

> IPP

In order to use Microsoft LPR, it must first be installed on your 
system.

OKI LPR

Please follow the procedure described in the Windows 95/98/Me 
section on page 83.

Microsoft LPR

To install this port, the following needs to be carried out:

1. Select [Start], [Settings], [Control Panel and Printers].

2. Open the [Printers] folder.

3. Double-click [Add Printer] and then select [Next].

4. Select [Local Printer], clear the [Automatically detect my 
printer] check box, and then select [Next].

5. Select [Create a new port] and then [LPR Port].

6. Select [Next] and then provide the following information:
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In [Name or address of server providing LPD] enter the host 
name or Internet Protocol (IP) address of the host for the 
printer you are adding.

In [Name of printer or print queue on that server] type lp.

Follow the instructions on the screen to finish installing the 
TCP/IP printer.

Port 9100

1. Select [Start] → [Settings] → [Control Panel].

2. Open the [Printers] folder.

3. Double-click [Add Printer] and then select [Next].

4. Select [Local Printer], clear the [Automatically detect my 
printer] check box and then click [Next].

5. Select [Create a New Port] and select [ Standard TCP/IP 
Port].

6. Select [Next].

7. The [Welcome to the Add Standard TCP/IP Printer Port 
Wizard] will appear.

8. Select [Next] and provide the following information. Enter 
[Printer name] or IP address, for example: 172.168.1.31. If 
the above IP address is entered, the Port Name will default 
to IP_172.168.1.31.

9. Select [Next]. Additional port information will be required.

10. Under [Device Type], select [Custom] then [Settings].

11. Ensure [Protocol] is set to [Raw].

12. Ensure [Port Number] is 9100 and [SNMP Status Enabled] is 
deselected.
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13. Select [OK].

14. Select [Follow the instructions on the screen to finish 
installing the  printer.]

IPP

1. Select [Start]→[Settings]→[Control Panel and Printers].

2. Open the [Printers Folder].

3. Double-click [Add Printer] and then select [Next].

4. Select [Network Printer].

5. Select [Next]. 

6. Type printer URL in text box labelled [Connect to a printer in 
the Internet or your Intranet], e.g. http://172.168.1.31/ipp/
lp.

7. Select [Next]. 

8. Install printer driver.
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Windows XP

Windows XP requires administrator privileges.

With Windows XP, there are four options for printing using TCP/IP.

> Oki LPR

> Microsoft LPR

> Port 9100

> IPP

In order to use Microsoft LPR, it must first be installed on your 
system.

OKI LPR

Please follow the procedure described in the Windows 95/98/Me 
section on page 83.

Microsoft LPR

To install this port, the following needs to be carried out:

1. Select [Start]→[Settings]→[Control Panel]→[Printers and 
Other Hardware].

2. Select [Printers and Faxes].

3. Click [Add Printer], then select [Next].

4. Select [Local printer attached to this computer], clear the 
[Automatically detect and install my Plug and Play printer] 
check box, and then click [Next].

5. Select [Create a New Port] and  [Type Standard TCP/IP 
Port]. 
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6. Click [Next].

7. [Welcome to the Add Standard TCP/IP Printer Port Wizard]  
appears.

8. Click [Next] and provide the following information. Enter 
[Printer name or IP address], for example: 172.168.1.31. If 
the above IP address is entered, the Port Name will default 
to IP_172.168.1.31.

9. Click [Next]. [Additional Port Information Required] 
displayed.

10. Under [Device Type], select [Custom] then [Settings].

11. Ensure [Protocol] is set to [LPR].

12. Ensure [Queue Name] is lp and [SNMP Status Enabled] is 
deselected.

13. Click [OK].

14. Follow on screen instructions to finish installing the printer.

Port 9100

1. Select [Start]→[Settings]→[Control Panel]→[Printers and 
Other Hardware].

2. Select [Printers and Faxes].

3. Click [Add Printer] and then click [Next].

4. Select [Local printer attached to this computer], clear the 
[Automatically detect and install my Plug and Play printer] 
check box, and then click[Next].

5. Select [Create a New Port] and select [Type Standard TCP/IP 
Port]. 

6. Click [Next].
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7. [Welcome to the Add Standard TCP/IP Printer Port Wizard]  
appears.

8. Click [Next] and provide the following information. Enter 
[Printer name or IP address], for example: 172.168.1.31. If 
the above IP address is entered, the Port Name will default 
to IP_172.168.1.31.

9. Click [Next]. [Additional Port Information Required] is 
displayed.

10. Under [Device Type], select [Custom] then [Settings].

11. Ensure [Protocol] is set to [Raw].

12. Ensure [Port Number] is 9100 and [SNMP Status Enabled] is 
deselected.

13. Click [OK].

14. Follow the instructions on the screen to finish installing the 
printer.

IPP

1. Select [Start], [Settings], [Control Panel]. and [Printers and 
Other Hardware].

2. Select [Printers and Faxes].

3. Click [Add Printer] and then select [Next].

4. Select [A network printer, or a printer attached to another 
computer].

5. Click [Next].

6. Select [Connect to a printer on the Internet or on a home or 
office network] and type printer URL in text box, e.g. http://
172.168.1.31/ipp/lp.
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7. Click [Next].

8. Install printer driver
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Novell Netware IPX

IPX is used with Novell NetWare. The OkiLAN supports Novell 3, 4, 
5 and 6, and allows print jobs to be directed to the appropriate 
Novell print queue. Please refer to the relevant section of this 
manual for additional information. 

NetBEUI Protocol

NetBEUI is a protocol that was designed for use on small 
workgroups or LANs. Within Windows, NetBEUI is used for file and 
printer sharing between computers. It provides a simple method of 
printing, but the protocol does have limitations and is not as robust 
as TCP/IP or IPX. Typically it is employed in small or home 
networks. 

Network Printer Settings

There are three configurable items under NetBEUI within the 
printer. These can be configured using the standard set-up utility 
described in Chapter 1.

 

1Although the workgroup name can be changed, it is recommended that it remain  PrintServer.

Although there are some differences in configuration options 
between the various Windows platforms, the procedure for printing 
using NetBEUI is the same.

Please ensure the NetBEUI protocol has been installed in Windows. 
This can be confirmed by checking the network settings. If NetBEUI 
has not been installed please refer to the section below.

The relevant Windows installation CD-ROM may be required and 
you should follow the on-screen dialogue box prompts.

Computer Name: Name assigned to the printer

Workgroup: PrintServer1

Comment: User definable description
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Windows 95/98/Me

1. Click [Start] → [Settings] → [Control Panel].

2. In the Control Panel double-click on the [Network] icon. 

3. In the Network dialogue box select [Configuration Panel].

4. If [Client for Microsoft Networks] is not listed, click  [Add].

5. In the [Select Network Component Type] dialogue box, 
select [Protocol] then [Add].

6. In the [Select Network Protocol] dialogue box, select 
[Microsoft] from the list of manufacturers, then select 
[NetBEUI] from the list of [Network Protocols] and then click 
[OK]. 

7. The Windows installation CD-ROM may be required. Follow 
the remaining dialogue box prompts.

Windows NT 4.0

1. Click the [Start] button, select [Settings] and then [Control 
Panel]. 

2. Double-click the [Network] icon. 

3. In the [Network] dialogue box, click the [Protocols] tab. 

4. If the [NetBEUI Protocol] is not listed, click  [Add]. 

5. In the [Select Network Protocol] dialogue box, select 
[NetBEUI Protocol] and click [OK]. 
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Windows 2000

1. Click the [Start] button, select [Settings] and then click 
[Network and Dial-up Connections]. 

2. Double-click the [Local Area Connection] icon. In the [Local 
Area Connection Status] dialogue box, click  [Properties]. 

3. In the [Local Area Connection Properties] dialogue box, if 
the [NetBEUI Protocol] is not listed, click [Install]. 

4. In the [Select Network Component Type] dialogue box, 
select [Protocol] and click  [Add].

5. In the [Select Network Protocol] dialogue box, select 
[NetBEUI Protocol] and click [OK]. 

6. Click [Close] in the [Local Area Connection Properties] 
dialogue box. 

7. Click the [Close] button in the [Local Area Connection Status] 
dialogue box. 
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Windows XP

Although you can install the NetBEUI protocol into Windows XP, it 
is not supported. You should be able to use NetBEUI on LAN 
connections although you will not be able to use this on Remote 
Access Service Connections.

1. In the [Start] menu, select [Settings] then [Control Panel].

2. Double-click  [Network Connections].

3. Right-click the adapter you wish to add NetBEUI to and then 
click [Properties].

4. On the [General] tab, select [Install].

5. Select [Protocol] and then [Add].

6. Select [Have Disk] and insert your Windows XP CD-ROM. 
Open the Valueadd\msft\net\netbeui folder, click the 
Netnbf.inf file and then click [Open]. Now the printer has 
been configured and NetBEUI has been installed; you can 
configure Windows to print over the network.
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Printer driver configuration

In the following example, the printer has been configured as 
follows:

   

1. Set up the printer driver as the default local printer.

2. In the [Start] menu, select [Settings] then [Printers].

3. Select the relevant printer driver, then [Properties].

4. Click on the [Details] tab in the printer driver.

5. Select [Add Port]. Select [Network] and click [Browse].

6. Double-click [Entire Network], [PrintServer] and 
[OL07DB85]. 

7. Select [Prn1] and click OK.

8. Check that [Network] is selected and click [OK]. 

9. Select [Apply] and [OK] to close [Properties].

> Printing can be carried out using the application software.

> The Master Browser function manages machine information 
from the same Workgroup, and replies to summary requests 
from other workgroups.

> The Master Browser function operates only if the Workgroup 
name is PrintServer.

Computer Name: OL07DB85

Workgroup: PrintServer
Comment: EthernetBoard OKILAN 
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> The Master Browser function can only manage this network 
card. If the PrintServer name is put into another Workgroup, 
the network card will not be able to find it on the network.

> A maximum of eight Ethernets can be managed by the Master 
Browser function.

> Printing cannot be carried out and an error message appears 
when jobs from other users (including other protocols) are 
being printed. 
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Novell NetWare
Overview

The OkiLAN print server supports the Novell NetWare environment.

It is necessary to have NetWare Administrator or Supervisor rights 
to change the configuration. This guide is for NetWare 
administrators. It should be read in conjunction with the relevant 
Novell NetWare manual. The latest Novell service packs and Novell 
client versions should be installed.

Supported Versions and Modes

In NDS, the printer can be configured to work in either print server 
mode or remote printer mode.

Remote Printer Mode

Remote Printer Mode requires a connection to be made to a 
workstation running Pserver. Print jobs are received from the file 
server via the NetWare print server. The network interface card 
emulates the workstation on which the NetWare Rprinter operates. 
Remote Printer Mode adds additional traffic to the network and is 
slower than Print Server Mode but does not require any additional 
licenses.

Print Server Mode (Recommended)

In Print Server Mode, the file server is logged in and the printer 
queue is repeatedly polled to determine whether a print job exists. 
The NetWare print server or workstation where Pserver runs is 
emulated. This enables high speed printing without applying a load 
to the network. Print Server Mode requires a single user NetWare 
license.

NetWare 3.11 + Bindery
NetWare 4.1+ Bindery and NDS
NetWare 5+ Bindery, NDS and NDPS
NetWare 6 Bindery, NDS, NDPS and iPrint
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Printing the Network Interface Card Configuration Sheet

The printer’s configuration page reports information that is 
required for NetWare configuration. To print a configuration page, 
while the printer is switched on, depress the NIC’s push-button for 
two seconds and then release.

The Ethernet address (MAC Address) of the printer can be found on 
the self-diagnostic printout, which can be printed by pressing the 
push-button on the network card for two seconds and then 
releasing it. 

The first six digits of the Ethernet address are the same for all 
OkiLan print servers. The last six digits of the Ethernet address are 
unique to each card

This is all the information that is required to setup the OkiLan for 
NetWare.
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Setup Utilities

Use NWAdmin32 or the Pconsole utility to create and setup 
NetWare printer objects. Please refer to Novell documentation for 
instructions on how to achieve this.

Use the OKI Network Card Setup Utility (Quick Setup) or other 
printer manager software, (AdminManager, Web browser, etc.) to 
configure the network interface card. For instructions please refer 
to the Configuration Utility section and online help. 
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UNIX
Overview

The OkiLAN print server supports many protocols such as LPD, FTP, 
TELNET, SNMP and IPP, and works within the UNIX environment.

To use the network card within the UNIX environment, the 
following steps are required:

Configuration

Network Interface card setting

The first step in installing the network card under UNIX is to set up 
the IP address, Subnet Mask and Gateway. This section explains 
one way to set them up from a UNIX workstation.

> The network addresses used in this manual are shown as 
examples only. Network addresses used in your installation 
must be generated for your own network.

> Log in as [root] to change the configuration of the Print 
Server. By default, there is no root password.

> If an incorrect IP address, Subnet Mask or Gateway is 
entered, the network may go down or other damage may 
occur. Check the address with your network manager.

The following explanation uses Sun Solaris 2.8 (Solaris 8) as an 
example. The actual commands may differ between versions of 
UNIX, so refer to the workstation manuals for more information.

1. Log in as root to the workstation

If you do not have superuser rights, the network manger 
should conduct the configuration.

2. If the print server does not have an IP addresses already 
assigned, use the arp command to set a temporary IP 
address.
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Example: for IP address 172.68.20.127 and network card 
address 00:80:92:01:00:D2

# arp –s 172.168.20.127 00:80:92:01:00:D2 temp

The Ethernet address (MAC address) 00:80:92:01:00:D2 in 
the above example can be determined from the network card 
self-diagnostic test which can be printed by pressing the 
push-button on the network card for two seconds and then 
releasing it. 

3. Use the ping command to confirm the connection with the 
network interface card.

Example: for IP address 172.168.20.127

# ping 172.168.20.127

If there is no reply, there is a problem with the configuration 
of the IP address (the IP address has been already set 
manually or by the DHCP/RARP server), or with the network. 
Reset the network interface card settings to default and try 
to set temporary IP address.

If you still have the problem after resetting the network 
interface card, consult the network manager.

4. Log in to the network interface card using TELNET.

Example: Logging in to IP address 172.168.20.127

#telnet 172.168.20.127

Trying 172.168.20.127

Connected to 172.168.20.127

Escape character is ‘^]’.

EthernetBoard OkiLAN 
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login: root

‘root’ user needs password to login.

password: <CR>

User ‘root’ logged in.

No. Message Value (level .1)

1 : Setup TCP/ IP

2 : Setup SNMP

3 : Setup NetWare

4 : Setup EtherTalk

5 : Setup NetBEUI

6 : Setup printer port

7 : Display Status

8 : Setup printer trap

9 : Setup SMTP Email

97 : Reset to factory set

98 : Quit setup

99 : Exit setup

Please select (1- 99)?

5. Type 1 and  press the [Enter] key. Perform the following 
settings:

Please select (1- 99)? 1
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No. Message Value

1 : TCP/ IP protocol : ENABLE

2 : IP address : 172.168.20.127

3 : Subnet Mask : 255.255.255.0

4 : Gateway address : 172.168.20.1

5 : RARP protocol : DISABLE

6 : DHCP/ BOOTP protocol: DISABLE

7 : root password : “ “

99 : Back to prior menu

Please select (1- 99)?

6. Log out from the network interface card. Turn the printer off 
and on again to validate the following settings.
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Operating system configuration

This section explains how to configure a printer for major UNIX 
operating systems.

Sun OS 4.x.x (BSD) configuration

The following explanation uses Sun OS 4.1.3 and an OKI printer as 
examples. The absolute path of commands and the configuration 
method may differ between OS versions, so refer to the 
workstation manuals for more information.

If an incorrect IP Address, Subnet Mask or Gateway is entered, the 
network may go down or other damage may occur.  Check the 
address with the network manager and confirm that the IP address 
of the printer has been set. 

1. Log in as root to the workstation. 

If you do not have Superuser rights, the network manager 
should conduct the configuration.

2. Register the IP address of the network card and the host 
name in the /etc/hosts file.

Example: for IP address 172.168.20.127 and host name 
PRINTER

172.168.20.127 PRINTER

3. Use the ping command to confirm connection with the 
network card.

Example: for host name PRINTER

# ping PRINTER

If there is no reply, then there is a problem with the 
configuration of the IP address (the IP address has been 
already set manually or by the DHCP/RARP server) or with 
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the network. Reset the network interface card settings to 
their defaults and then try to set a temporary IP address. If 
you still have the problem after resetting the network 
interface card, consult the network manager.

4. Register the printer in the /etc/printcap file.

Example: for host name PRINTER, to create a queue called 
PRINTER_lp

PRINTER_lp: \

:lp=:rm=C7400:rp=lp:\

:sd=/usr/spool/PRINTER_lp:\

:lf=/usr/spool/PRINTER_lp/OKIPRINTER_lp_errs:

PRINTER_lp The name of the printer queue

lp: The name of the device used to connect to the printer.  
Does not need to be specified for a remote machine.

rm: The name of the host of the remote printer. This should 
be the same as the name added to the /etc/hosts file.

rp: The name of the printer on the remote printer.  It should 
be lp.

sd: The spool directory.  Give the absolute path.

lf: The error log file. Give the absolute path.

5. Create the spool directory and error log file.

Example: for spool Directory PRINTER_lp and Error Log file 
OKIPRINTER_lp_errs

# mkdir /usr/spool/PRINTER_lp

#touch/usr/spool/PRINTER_lp/PRINTER _lp_errs
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
UNIX - 106



# chown –R daemon /usr/spool/PRINTER_lp

# chgrp –R # daemon /usr/spool/PRINTER_lp

6. Check that lpd (printer daemon) is activated.

# ps aux | grep lpd

7. If lpd is not running,start it by logging in as superuser and 
executing

# /usr/lib/lpd &

Sun Solaris 2.x configuration

Admintool is normally used to register remote printers on Open 
Windows. However, it cannot be used here, as the data recipient 
and queue have the same name. The procedure below must be 
used for registering a remote printer.

If Solaris 2.x is connected to the remote printer for a long period 
according to the system specifications, errors and forced 
disconnection may occur. Therefore, if paper tearing, off-line and 
other errors result in waiting time, printing may have to be 
aborted.

If an incorrect IP address is entered, the network may go down or 
other damage may occur. Configure after consulting the network 
manager.

The following explanation uses Sun Solaris 2.8 (known as Solaris 
8) and an OKI printer as examples.  The absolute path and method 
of configuring commands may differ in other versions of the OS.  
Refer to the workstation manual for more details.

1. Confirm that the IP address of the printer has been set.

2. Log in as [root] to the workstation. If you do not have 
superuser rights, the network manager should conduct the 
configuration.
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3. Register the IP address of the network card and the host 
name in      /etc/hosts file.

Example: for IP Address 172.168.20.127 and host name 
PRINTER

172.168.20.127PRINTER

4. Use the ping command to confirm connection with the 
network card.

Example: for host name PRINTER

# ping PRINTER

If there is no reply, there is a problem with the configuration 
of the IP address (the IP address has been already set 
manually or by the DHCP/RARP server), or with the network. 

Reset the network interface card settings to default and try 
to set temporary IP address. If you still have the problem 
after resetting the network interface card, consult the 
network manager.

5. Register the network card as a remote printer server.

Example: for host name PRINTER

a. Stop the print scheduler.

# usr/sbin/lpshut

b. Create the printer queue.

# /usr/sbin/lpadmin -p PRINTER_lp  -v /dev/null \

m netstandard -o dest=PRINTER:lp

-o protocol=bsd

c. Set the queue to accept PostScript print jobs.
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# /usr/sbin/lpadmin -p PRINTER_lp -I postscript

d. Start the print scheduler.

# /usr/sbin/lpsched

e. Activate the print queue.

# /usr/sbin/accept PRINTER_lp

f. Enable the print queue

# /bin/enable PRINTER_lp

To customize output, for example to add additional commands at 
the start of each print job, you can edit a copy of the netstandard 
model file then add it using the lpadmin command

Example: for printer PRINTER_lp, with model file called 
PRINTER0_model

# /usr/sbin/lpshut

# /usr/sbin/lpadmin –p PRINTER_lp –m 
PRINTER_model

# /usr/sbin/lpsched

HP-UX 10.x configuration

If an incorrect IP Address, Subnet Mask or Gateway is entered, the 
network may go down or other damage may occur.  Check the 
address with the network manager.

The following example uses HP-UX10.20 and an OKI printer as 
examples. The absolute path and method of configuring commands 
may differ in other versions of the OS.  Refer to the workstation 
manual for more details.

1. Confirm that the IP address of the printer has been set.  See 
network interface card IP address configuration for more 
information.
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2. Log in as [root] to the workstation. If you do not have 
superuser rights, the network manager should conduct the 
configuration.

3. Register the IP Address of the network card and the host 
name in  the /etc/hosts file. 

Example: for IP Address 172.168.20.127 and host name 
PRINTER

172.168.20.127 PRINTER

4. Use the ping command to confirm connection with the 
network card.

Example: for host name PRINTER

# ping PRINTER

If there is no reply, there is a problem with the configuration 
of the IP address (the IP address has been already set 
manually or by the DHCP/RARP server), or with the network. 
Reset the network interface card settings to default and try 
to set a temporary IP address. If you still have the problem 
after resetting the network interface card, consult the 
network manager.

5. If remote spooling is not already enabled on the HP-UX 
machine, carry out the following configuration.

a. Stop the printer spooler.

# /usr/sbin/lpshut

b. Add the following line to the /etc/inetd.conf file and 
register the remote spooler.

printer stream tcp nowait root /usr/sbin/rlpdameon –I

c. Restart inetd
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# /etc/inetd –c

4. Register the remote printer

Example: setting up a queue called PRINTER_lp to print to 
host PRINTER

a. Register the remote printer.

# /usr/sbin/lpadmin -pPRINTER_lp -v /dev/null 

-mrmodel \-ormPRINTER -orplp -ocmrcmodel 

-osmrsmodel -ob3

b. Activate the print queue.

# /usr/sbin/accept PRINTER_lp

c. Enable the print queue.

# /bin/enable PRINTER_lp

d. Enable the printer spooler.

# /usr/sbin/lpsched

To customise output, for example, to add additional commands at 
the start of each print job, you can edit a copy of the /usr/spool/
lp/model/rmodel model file then add it using the lpadmin 
command.

Example: for printer PRINTER_lp, with model file called 
PRINTER_model

# /usr/sbin/lpshut

# /usr/sbin/lpadmin –pPRINTER_lp –
mPRINTER_model

# /usr/sbin/lpsched
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AIX 4.1.5 configuration

The following explanation uses AIX4.1.5 and an OKI printer as 
examples. The absolute path of commands and the method of 
configuring may differ with the OS version. Refer to the 
workstation’s manual. If an incorrect IP address is entered, the 
network may go down or other damage may occur. Configure after 
consulting the network manager.

1. Log in as [root]. If you do not have superuser rights, the 
network manager should conduct the configuration.

2. Register the IP address and the host name in the /etc/hosts 
file.

Example: for IP Address 172.168.29.127 and host name 
okiprinter

172.168.20.127 PRINTER

3. Use the ping command to confirm connection with the 
network card.

Example: for host name okiprinter

# ping PRINTER

If there is no reply, there is a problem with the configuration of the 
IP address (the IP address has been already set manually or by the 
DHCP/RARP server), or with the network. Reset the network 
interface card settings to default and try to set a temporary IP 
address. If you still have the problem after resetting the network 
interface card, consult the network manager.

4. Register the host that was previously registered as the print 
server.

Example: for the OKI printer registered as the print server

a. Add the print server.

# ruser –a –p okiprinter
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b. Activate the remote printer daemon.

# startsrc –s lpd

# mkitab ‘lpd:2:once:startsrc –s lpd’

3. Add the print queue using the smit command.

a. Activate the smit command and convert to the item 
[Add print queue].

# smit mkrque

b. Select [remote] (the printer connected to the remote 
host) from [Type of connection].

c. Select [Standard procedure] from Type of remote print.

d. Carry out the following settings in [Add a standard 
remote print queue]. If the configuration differs from 
below, configure according to environment.

Example: fr direct output port lp with print queue 
okiprinte_lp and  print server okiprinte

Queue to be added “printer_lp”

Host name of the 

remote server “printer”

Queue name of the 

remote server “lp”

Type of print spooler

of the remote server “BSD”

Description of printer name
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of the remote server “Optional comment”

LPD Printing

Line Printer Daemon (LPD) is the most common protocol for 
printing with TCP/IP to a network printer. Refer to the 
workstation’s manual for details of lpr and lp commands. The 
following explanation in this section uses the printing of print file 
test.prn with printer name PRINTER_lp as an example.

Logical printers

The OkiLAN print server includes three logical printers.

> lp must be used for printing a file created using the printer 
driver.

> sjis must be used for printing a text file of Shift JIS Kanji 
code.

> euc must be used for the printing a text file of the EUC Kanji 
code.

> sjis and euc function only as PostScript printers. 

BSD-based UNIX

Print using the lpr command.

# lpr –PCprinter_lp test.prn

If the lprm command is used, the print job is cancelled.

Example: To delete a print job (Job ID 123) on the 
okiprinter_lp 

Logical printer Printer function

lp For direct output
sjis For Shift JIS Kanji converted output
euc For EUC Kanji converted output
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# lprm –PCprinter_lp 123

Verify the printer status using the lpq command.

> The result of lpq may not be displayed correctly depending on 
UNIX operating system specification.

> While the short format of lpq is a UNIX compatible format, the 
long format is unique to  the OkiLAN print server.

Example of the short format: # lpq –PCprinter_lp

Example of the long format: # lpq –l -PCprinter_lp

System V-based UNIX

Print using the lp command.

# lp –d Cprinter_lp test.prn

Delete a print job using cancel command.

Example: To delete a print job (Job ID 456) in the printer_lp

# cancel Cprinter_lp  -456

Verify the printer status using the lpstat command.

# lpstat –pCprinter_lp

> The result of lpstat may not be displayed correctly depending 
on UNIX operating system specification (e.g. Solaris 2.x).

FTP printing

FTP (File Transfer Protocol) is used for transferring a file with TCP/
IP. If the print data is sent to a logical printer via FTP,  it is printed.

Refer to the workstation’s manual for details of the ftp command. 
The following explanation uses print file test.prn with printer name 
okiprinter_lp as an example.
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Logical directories

The OkiLAN print server includes three logical directories.

lp must be used for printing a file created using the printer 
driver.

sjis must be used for printing a text file of Shift JIS Kanji 
code.

euc must be used for the printing a text file of the EUC Kanji 
code

    

> jis and euc function only as PostScript printers. 

> You can not send data to the root directory.

1. Login to the network interface card.

When printing with ftp, use any values for name and 
password. However, if the user name is [root], the password 
set under TELNET or the utility are required. See the 
appropriate section for details.

Example: Logging in with host name printer (or  IP address 
172.168.20.127).

# ftp printer (or ftp 172.168.20.127

Connected to Cprinter

220 EthernetBoard OkiLAN Ver 1.1.0 FTP Server

Name (Cprinter:root) : root

Logical directory Printer function

lp For direct output
sjis For Shift JIS Kanji converted output
euc For EUC Kanji converted output
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331 Password required.

Password:<CR>

230 User Logged in

ftp>

The network card logical directory structure is hierarchical. 
Move to the logical directory; it is not possible to output print 
data to the root directory. 

2. Move to the preferable logical directory using the cd 
command. 

Example: moving to the lp directory and confirming the 
current directory.

ftp> cd /lp

250 Command OK.

ftp> pwd

257 ”/lp” is current directory

ftp>

3. Configure the transfer mode

There are two types of transfer mode: BINARY mode, in 
which the file contents are output as it is and ASCII mode, 
which converts the LF code to the CR+LF code. If a binary file 
converted by the printer driver is transferred, the transfer 
mode has to be BINARY mode.

Example: changing transfer mode to binary mode and 
verifying the current mode

ftp> type binary
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200 Type set to I.

ftp> type

Using binary mode to transfer files.

ftp>

4. Transfer the print data to the network card using the put 
command. Two methods of file transfer using the put 
command are available.

Example: transferring print data test.prn

ftp> put test.prn

Example: transferring print data specified by absolute path/
users/test/test.prn

ftp> put /users/test/test.prn /lp

5. Logout from the network card using the quit command

ftp> quit

Three states can be verified using the quote command stat: 
the IP address, login user name and transfer mode. In 
addition, printer status can be verified by specifying the 
directory after the stat (lp, sjis, euc).

Example: displaying network card status

ftp> quote stat

211-FTP server status:

Connected to: 172.168.20.10.000.00

User logged in: root

Transfer type: BINARY
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Data connection: Closed.

211 End of status.

ftp>

Example: displaying the network card status (directory 
name: lp)

ftp> quote stat /lp

211-FTP directory status:

Ready

211 End of status

ftp>
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Apple® Macintosh® 
Overview

The OkiLAN print server supports the Apple Macintosh AppleTalk 
environment. This guide is for administrators and it should be read 
in conjunction with the relevant Macintosh manual. The latest 
Macintosh service packs should be installed.

Supported Versions

Mac OS X.1 and forward are supported.

Printing the Network Interface Card Configuration 
Sheet

The printer’s configuration page reports information that is 
required for Macintosh configuration. To print a configuration page, 
while the printer is switched on, depress the NIC’s push-button for 
two seconds and then release.

The information that you require is the printer’s Ethernet address 
(MAC address). It is displayed at the top of the first page under the 
title General Information.

The first six digits of the Ethernet address are the same for all 
OkiLAN  print servers. The last six digits of the Ethernet address 
are unique to each card.

This is all the information that is required to setup the OkiLAN print 
server for Macintosh.
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Installation

Install the Driver

1. Place the CD, supplied with your printer, in the CD-ROM 
drive. 

2. Double-click the icon that appears on the desktop.

3. Open the MAC folder.

4. Double-click the Printer Installer icon, click Continue.

5. Installer displays with the driver selected.

6. Select any utilities you want to install. Click Install.
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Macintosh Printer Setup

OS X.1 and above

In Mac OS X you use the Print Center to setup network printers.

1. Run the Print Server or Print Setup Utility.

2. Select OKI TCP/IP from the drop-down menu.

3. Enter the printer IP address.

4. From the Printer Model drop down menu, select your printer 
model.

5. Click Add.

6. Quit the Print Center.
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Troubleshooting
The network addresses used in this manual are shown for example 
only. Network addresses used in your installation must be 
generated from your own network.

Self-diagnostic test

Printer does not print.

Ensure the printer emulation is set to PS (if available)  or 
Automatic.

NG is printed in the Self-diagnostic test.

Confirm that the NIC is installed correctly in models that require an 
optional NIC card and turn the printer off and on again.

Ensure the network cable is correctly connected and connect to a 
different network segment, rerun the test and see if this cures the 
fault.

EEPROM Check registers NG.

Confirm that the NIC is installed correctly and turn the printer off 
and on again.

Initialize the NIC.

TCP/IP

Printer cannot find the network interface card.

Turn the printer off and on again.

Confirm the network interface is enabled on the printer.

Check there is a response to the interface card command.

Check the network cable is correctly connected. 
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Troubleshooting - 123



Change the cable and try again.

Run the Self-diagnostic test. 

Check the IP Address, Subnet Mask and Gateway are correct. 

Check that the TCP/IP protocol is set to Enable.

Reset the network interface card to factory default settings.

If DHCP, BOOTP and RARP are not used, ensure they have been set 
to Disable.

Cannot print with lpr and ftp.

Turn the printer off and on again.

Check there is a response to the ping command.

Check the network cable is correctly connected. 

Change the cable and try again.

Check the host name and IP address are configured in the 
workstation.

Check the printer port name is configured in the workstation.

There are three port names: lp, euc and sjis. Use lp by default as 
euc and sjis are specific to printers with PostScript available. 

Incorrect User name on the banner page.

If printing with lpr, the User name printed is unknown and the 
Filename printed is the Spool file name.

If printing with FTP, the User name printed is the User name 
entered during FTP login and the File name printed is the 
Transmitted file name. If the Print Directory name is indicated in 
the put command, the File name is not printed. The Printer name 
printed is the Logical Directory name.
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NetWare

Printer cannot find the network print server.

Turn the printer off and on again.

Confirm the network interface is enabled on the printer.

Check the network cable is correctly connected. 

Change the cable and try again.

If the standard configuration utility is used, check the NetWare 
network number in the environment settings. 

If the NetWare protocol is disabled, set it to Enable.

Reset the network interface card to factory default settings.

The network print server is identified by the setup utility but not by 
the NetWare server.

Start up the NetWare server and check the NIC configuration.

Check the NSAP packet on the NetWare server is not set to Disable.

Remote Server mode

Check the correct print server is operating on the file server.

Check the Print Server name operating on the File Server and the 
Print Server name set in the NIC are the same.

Check the Printer name displayed in the Print Server monitor of the 
File Server and the NetWare Port name set in the NIC are the same. 
If there are multiple network interface cards, configure the 
NetWare Port names to be different.
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Print Server mode

Check the File Server name set in the NIC and on the File Server 
are the same.

Check the Printer name set in the File Server and the NetWare Port 
name set in the NIC are the same. If there are multiple NICs, 
configure the NetWare Port names to be different. 

Check the NetWare login password is correct.

Check the Machine name is the same as the Print Server name set 
in the File Server.

Printer does not print.

Check the network cable is correctly connected. 

Change the cable and try again.

Turn the printer off and on again.

Check the NIC is connected to the File Server.

Check the printer driver has been mapped to the correct 
netware queue.

PostScript error occurs if a Banner Page is printed.

A PostScript Banner page cannot be printed in NetWare 3.12 
Remote Printer mode. If a PostScript printer is used and a 
Banner Page is printed, PostScript error is displayed. Turn 
the banner output Off in the client’s printer settings.
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EtherTalk

Not identified by the Chooser and the Setup Utility.

Turn the printer off and on again.

Check the network cable is correctly connected. 

Change the cable and try again.

If the network resides in a Zone, check the correct Zone name is 
selected in the Chooser. 

Check the Zone name in the utility related to the NIC is the same 
as the Zone name set in NIC.

Check AppleTalk, which is displayed at the right bottom of the 
Chooser, is set to Enable. (In some OS versions Network is used 
instead of AppleTalk.)

Check Ethernet is selected in AppleTalk. (In some OS versions 
Network is used instead of AppleTalk.)

Check the print driver is selected in the Chooser.

Check the EtherTalk protocol is set to Enable.

Print the NIC settings and confirm that the EtherTalk Port name is 
not blank.
OkiLAN 8300e Network User’s Guide, C6000n and C6100 Series
Troubleshooting - 127



NetBEUI

The network interface card is not identified.

Turn the printer off and on again.

Check the network cable is correctly connected. 

Change the cable and try again.

Check Microsoft network client and NetBEUI have been added to 
the network section of the control panel.

Check the NetBEUI protocol is set to Enable.

Check the factory setting of the workgroup name is PrintServer and 
the computer name is ML+ the last six digits of the MAC address.

Check the computer name of the NIC is different from the 
computer name on the network. 

Error writing to Prn1.

Check the printer is online.

If there is an error message indicating the paper has run out, add 
more paper and cancel the error.

Check whether another user is printing. Print after the other user 
has finished.
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